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Thank you for choosing Garmin MapSource®—the complete tool for
managing your Garmin GPS unit. MapSource provides geographic data on
a CD-ROM to view on your computer or add to the basemap of your GPS
unit.

In this manual, you will learn how to view existing waypoints, routes,
and tracks on a map by receiving information from your GPS unit. You will
also learn to create new waypoints or routes with a click of the mouse and
send them to your GPS unit. The manual is organized into six sections:

Introduction— contains important introductory material.

Getting Started— includes information about installing and unlocking
your MapSource product and connecting your GPS unit to your PC.

User’s Interface— describes MapSource menus, toolbars, and main
features in detail.

Reference— gives step-by-step instructions so you can transfer maps
and other data to and from your GPS unit and learn to create your own
waypoints, routes, and tracks.

Appendix— contains keyboard shortcuts, map legends, and the Soft-
ware License Agreement.

Index

Enjoy MapSource, and thank you again for choosing Garmin!

Product Registration

Help us better support you by completing our online registration
today! Have the serial number of your MapSource software handy and
connect to our Web site (http://www.garmin.com). Look for the Product Reg-
istration link on our Home page. Also, be sure to record your serial number
in the right-hand column of this page.

Introduction

Registration and Support

Use this area to record the serial number (8-digit number located on

the back of the box) in case your MapSource software is lost, stolen,

or needs service. Be sure to keep your original sales receipt in a safe
place or attach a photocopy inside the manual.

Serial Number:

Contact Garmin Customer Service
Should you encounter any difficulty while installing MapSource or if
you have any questions about MapSource, contact Garmin’s Product
Support Department by phone at 800-800-1020, Monday — Friday,
8am -5 pm Central Time, or by e-mail at sales@garmin.com.
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Map Data Information: One of Garmin’s goals is to provide customers
with the most complete and accurate cartography that is available to us at
a reasonable cost. We use a combination of governmental and private data
sources which we identify as required in product literature and copyright
messages displayed to the consumer. Virtually all data sources contain inac-
curate or incomplete data to some degree. This is particularly true for areas
outside the United States, where complete and accurate digital data is either
not available or is prohibitively expensive.

1f the data source lacks a feature, or if an item is mislocated or misidenti-
fied, it will be incorrectly identified or missing in the Garmin cartography
product as well. Each MapSource product has its strengths and weaknesses,
and not all are suitable for every purpose. Please keep this in mind as you
use and enjoy the benefits the cartography provides.

Garmin encourages customers to report any errors found in our
electronic maps by completing our online Error Reporting Form in the
Cartography section of our web site at: http://www.garmin.com/cartography/
mapSource/errorForm.html.

CAUTION: GARMIN MAKES NO WARRANTY AS TO THE AC-
CURACY OR COMPLETENESS OF THE MAP DATA IN THIS PRODUCT
AND DISCLAIMS ANY AND ALL EXPRESS, IMPLIED, OR STATUTORY
WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANT-
ABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IT IS THE USER'S
RESPONSIBILITY TO USE THIS PRODUCT PRUDENTLY. THIS PRODUCT
IS INTENDED TO BE USED ONLY AS A TRAVEL AID AND MUST NOT
BE USED FOR ANY PURPOSE REQUIRING PRECISE MEASUREMENT OF
DIRECTION, DISTANCE, LOCATION, OR TOPOGRAPHY.

Introduction

Warnings and Cautions
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Warnings and Cautions

BlueChart®

The following Warnings and Cautions may apply to some or all of the
content in the MapSource BlueChart™ CD-ROM:

WARNING: No National Hydrographic Office has verified the
information in this product and none accept liability for the accuracy of
reproduction or any modifications made thereafter. No National
Hydrographic Office warrants that this product satisfies national or
international regulations regarding the use of the appropriate products for
navigation.

WARNING: This product has been produced, in part or whole, from
the United Kingdom Hydrographic Office products. No liability is accepted
for the use of this product and it must not be used to assist in navigation.
The digital chart(s) contained herein have not been verified or updated. For
your safety, users are advised to consult official updated nautical charts for
navigational purposes.

The Hydrographic Office has not verified the extracted data and the
printed chart should be consulted for full navigational details.

CAUTION: The Australian Hydrographic Office does not check the
information on this product and the Commonwealth accepts no liability for
the accuracy of copying or for any modifications that may have been made
to the information which it has supplied. Furthermore, the Commonwealth
does not warrant that this product meets any regulations as an appropriate
product for navigation or that it contains the latest hydrographic informa-
tion available.



Minimum System Requirements
Your computer should meet the following minimum system Gettmg Started

requirements:

¢+ IBM-compatible PC with Pentium processor or equivalent

o 16-32 Megabytes RAM, CD-ROM drive, mouse or other Installation Information
pointing device

*  256-color display adapter (24-bit color recommended) and monitor
with 640 x 480 resolution or higher

* A minimum of 20 Megabytes to 1.5 Gigabytes of free hard drive
space (depending on the map data)

MapSource requires a 32-bit operating system such as Windows
98/2000/ME/XP or Windows NT 4.0. When MapSource 6.0 is used on a
computer with Windows NT 4.0, Internet Explorer 4.0 or higher is also
required. You must have an available serial port or USB (Universal Serial
Bus) port (if applicable) to interface with a Garmin GPS unit.

Use of the Garmin USB Data Card Programmer accessory requires Win-
dows 98/2000, ME, or XP, and a USB Port.

Internet access is recommended for MapSource products that must be
unlocked, such as City Navigator and City Select® products.

Garmin GPS Unit Compatibility

MapSource is compatible with most Garmin GPS units and systems.
Refer to the Garmin Web site (http://www.garmin.com) for a complete list of
MapSource products and their compatibility with Garmin GPS units.



Data Transfer

Getting Started Data transfer and storage options vary with the type of Garmin GPS unit
you own. MapSource data storage options include Garmin data cards (avail-
able for use with selected Garmin GPS systems), Compact Flash (CF) and

. . Secure Digital (SD) cards, and your GPS unit’s internal memory. Be aware
Installation Information that when you transfer MapSource data to a storage card, the card may
overwrite old data with new data. See “Transferring Data,” p. 47.

NOTE: For best results, wait until after MapSource is fully
installed before connecting your GPS unit to your computer
to ensure that the proper drivers are installed. Some products
may have come with specific installation instructions. Follow
those instructions for the proper time to connect your device
to your computer.




Installing MapSource

The MapSource installation process varies, depending on the type
of mapping product you purchase. For example, City Select and City
Navigator require a Setup CD and two additional data CDs. Other products
require one or two data CDs but no Setup CD. If your MapSource product
includes a Setup CD, insert it into your computer first to begin installation.
If your product does not contain a Setup CD (only one or two data CDs
are included), insert Disc 1 into your computer and follow the installation
instructions.

If your Garmin GPS unit came with specific installation instructions,
follow those instructions. The following installation instructions are here to
assist you if you need to reinstall MapSource. Please note that your specific
installation may vary slightly from the installation instructions given in this
guide. The basic configurations for a MapSource installation are as follows:

¢+ Setup CD with one or two accompanying Data CDs— Refer to
the section titled “Installing MapSource from a Setup CD,” p. 4, for
Instructions.

*  Two Data CDs (labeled Disk 1 and Disk 2 or similar)—
Refer to the section titled “Installing MapSource from Data CDs,” p.
6, for instructions.

¢ One Data CD— Refer to the section titled “Installing MapSource
from Data CDs,” p. 6, for instructions.

Getting Started

MapSource Installation

& GARMIN

Install City Select

View MapSource Tutorlsl
Wisit Dur Website

Contact Garmin

Setup CD Main Menu
Above is an example of the options that appear when the Setup CD
runs on your computer. You may see different options, depending on
what MapSource product you purchased.



Installing MapSource from a Setup CD
Getti ng Started Following are installation instructions for MapSource products that
include a Setup CD. These products should also include two data CDs.

To install MapSource from the Setup CD:

MapSource |nsta||ation 1. Insert the MapSource Setup CD into your computer’s CD-ROM or
CD/DVD-ROM drive.

2. If auto-run is enabled, your computer should automatically run the
startup file. If the startup file does not run automatically, click the Start
button, select ‘Run...," and type the drive letter of your CD-ROM drive
followed by Setup.exe’ (example: D:\Setup.exe). Press Enter or click
OK.

N 20

Type the name of a program, folder, document, or
Internet resource, and Windows will open it For you,

Open: I D:\Setup.exe j
& GARMIN C ec ¥ Run insepatate mematy space

oK I Cancel | Bromse, .., |

Run Window
Instal ity Select 3. If you are prompted, select your language of choice. Then, from the
View MspSoures Tutorlal Main Menu screen, click ‘Install <Software name>" to begin the
Visit Our Website MapSource installation.

SRS From the Main Menu, you can view the MapSource tutorial, which
helps you learn about selecting and transferring detailed maps to your
Ext Garmin GPS unit. You can also visit the Garmin Web site and contact
Main Menu Screen Gam_n_n via e-mail. You may see different options, depending on your
specific MapSource product.

MapSource City Select Main Menu on the Setup CD shown
4. The InstallShield Wizard Welcome screen opens. Follow the directions
to continue installing the MapSource application.




5.

When prompted, remove the Setup CD from the CD-ROM drive. Insert
the CD labeled Disk 1 (or something similar) into your CD-ROM drive.

NOTE: Make sure the CD-ROM has stopped “spinning” before
you remove the CD. You will notice that the drive is making less
noise, indicating that it has stopped spinning (reading the CD).
When you insert another CD, wait a few moments for the drive to
start reading the CD before clicking OK to proceed.

The InstallShield Wizard opens again. Follow the InstallShield Wizard
instructions to finish installing detailed maps.

If you see the Setup Type screen (shown in the top right image),
select the type of setup to suit your needs. Select ‘Complete’ to install
all regions. Select ‘Custom’ to customize your install and display the
Select Regional Coverage Areas screen. Refer below for specific
information about this screen. Click Next to continue.

If you see the Select Regional Coverage Areas screen (shown in
the bottom right image), select the region(s) that you wish to install
to your computer’s hard drive. Unless you have limited space on your
computer’s hard drive, select ‘All Regions." Otherwise, view the cities/
states included in each region by highlighting the region and reading
the description that appears. Keep the ‘Program Files’ box checked
because these files are necessary in order to run MapSource on your
computer. Click Next to continue.

Continue following the directions to complete the installation. You will
be prompted to insert Disk 2, then Disk 1 again.

At the InstallShield Wizard Complete screen, click Finish to end
the installation. If your MapSource product must be unlocked, the
UnlockWizard opens at this time. Refer to the “UnlockWizard”
section, p. 8.
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Installing MapSource from Data CDs (without a Setup CD)
If your MapSource product does not include a Setup CD, follow the
instructions below.

To install MapSource software without a Setup CD:

1.

Insert the CD marked 'Disk 1." If your product includes only one CD,
insert it.

Your computer should automatically run the start-up file and display
a Welcome screen. If it doesn't run automatically, click Start and
select ‘Run...." Type the drive letter of your CD-ROM drive followed by
‘Setup.exe’ (example: D:\Setup.exe). Press Enter or click OK.

If you are prompted, select your language of choice. Then, from the
Main Menu screen, click ‘Install <Software name>" to begin the
MapSource installation.

From the Main Menu, you can view the MapSource tutorial, which
helps you learn about selecting and transferring detailed maps to your
GPS unit. You can also visit the Garmin Web site and contact Garmin
via e-mail. You may see different options, depending on your specific
MapSource product.

The InstallShield Wizard Welcome screen opens. Follow the directions
to continue installing the MapSource application.

The InstallShield Wizard opens again. Follow the InstallShield Wizard to
complete the detailed maps installation.

If you see the Setup Type screen (shown in the bottom left image),
select the type of setup to suit your needs. Select ‘Complete’ to install
all regions. Select “Custom’ to customize your install and display the
Select Regional Coverage Areas screen. Refer below for specific
information about this screen. Click Next to continue.



If you see the Select Regional Coverage Areas screen (shown in
the image to the right), select the region(s) that you wish to install
to your computer’s hard drive. Unless you have limited space on your
computer’s hard drive, select ‘All Regions." Otherwise, view the cities/
states included in each region by highlighting the region and reading
the description that appears. Keep the ‘Program Files’ box checked
because these files are necessary in order to run MapSource on your
computer. Click Next to continue.

7. Continue following the directions to complete the installation. If
prompted, insert Disk 2 and then Disk 1 again.

NOTE: Make sure the CD-ROM has stopped “spinning” before
you remove the CD. You will notice that the drive is making less
noise, indicating that it has stopped spinning (reading the CD).
When you insert another CD, wait a few moments for the drive to
start reading the CD before clicking OK to proceed.

8. At the InstallShield Wizard Complete screen, click Finish to end
the installation. If your MapSource product needs to be unlocked, the
UnlockWizard opens at this time. Refer to the “UnlockWizard"
section, p. 8.

Installation Notes

If you have previously installed other MapSource products on your hard
drive and/or you do not have enough hard drive space to install the entire
detailed map product database, try one of the following options:

¢ Select fewer coverage areas to download.

¢ Remove other programs from your hard drive.

*  Completely remove (uninstall) all MapSource products and reinstall
them to your hard drive. See p. 17.
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UnlockWizard

MapSource ﬂ
Unlock ;

MapSource products that require an Unlock Code
carry this symbol on the outside of the box.

NOTE: Not all MapSource products need
to be unlocked before they can be used.
If your MapSource program does not
have a 25-character Unlock Code or an
8-character Coupon Code, and you do
not see the above symbol on the outside
of the box, you DO NOT need to unlock
the maps to view map detail.

Unlocking Maps

Some MapSource products must be “unlocked” before you can view and
download the detailed map data. Those products come with either a 25-
character Unlock Code or an 8-character Coupon Code.

If your MapSource product needs to be unlocked before you can use it,
the UnlockWizard automatically runs at the end of the installation process.
Follow the directions on your computer screen and use the Unlock Code or
Coupon Code to unlock the map data and register your product.

If you did not unlock maps during installation, if you want to unlock an-
other MapSource region, or if you want to unlock maps for a second Garmin
GPS unit, you may do so using the UnlockWizard or the Garmin Web site,
http:/fwww.garmin.com/unlock/.

Unlock Codes and Coupon Codes

You need an Unlock Code or a Coupon Code to unlock your MapSource
product (if the product requires you to unlock it). You will have either an
Unlock Code or a Coupon Code in the packaging of your product.

An Unlock Code is a 25-character code that can unlock all maps as-
sociated with the MapSource product. The Unlock Code is printed on the
bottom of a yellow piece of paper. You will also see the unit’s serial number
and a 7-character Registration Code.

A Coupon Code is an 8-character code that you can redeem to unlock
a region. The Coupon Code is a printed sticker near the bottom of a tri-fold
piece of paper called an Unlock Certificate.

NOTE: Keep your Unlock Code/Unlock Certificate in a safe place.
You may need this information in the future if you need to re-
install MapSource. Garmin cannot give refunds or exchanges for
MapSource Unlock Codes.




Redeeming a Coupon Code

If you have an Unlock Certificate with an 8-character Coupon Code, use
that code to obtain your Unlock Code either by following the directions on
the Certificate or by using the UnlockWizard.

Using the UnlockWizard

If your MapSource mapping product needs to be unlocked, the
UnlockWizard will automatically open so you can enter your Unlock Code
or redeem your Coupon Code.

To open the UnlockWizard manually, open MapSource and press Ctrl
+ U on your keyboard. You can also click the Start button, select Pro-
grams, then select ‘UnlockWizard’ from the MapSource menu.

Follow the directions on your computer screen to enter a 25-character
Unlock Code or to redeem an 8-character Coupon Code that will unlock the
map data.

Once the map data is unlocked, the Unlock Code and coverage
area information will appear in the UnlockWizard. You can access the
UnlockWizard at any time through MapSource.

To open the UnlockWizard in MapSource:
1. Open MapSource.
2. Click Utilities and then ‘Unlock Maps' or press Ctrl + U.

Getting Started

UnlockWizard
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UnlockWizard Welcome Screen

NOTE: The UnlockWizard is not avail-
able in all MapSource products. If

your MapSource product needs to be
unlocked, it will have the UnlockWizard.




Entering an Unlock Code with a 25-Character Code

Getti ng Started Your MapSource product packaging may contain a yellow piece of paper
with a 25-character unlock code on it. If so, use this code to unlock your
MapSource product using the following instructions.

UnlockWizard To unlock your product with a 25-Character Unlock Code:
1. Open the UnlockWizard if it is not already open (see p. 9).
i 2. Click 'Yes, I have a 25-character unlock code.” Click Next.
e 3. Enter your 25-character unlock code and then a comment, if desired.
;n:.l:nmiunumm:m C||Ck Next.
Q.”:E:ﬁ:f:ﬁ“m 4. If you would like to register your product, you can do so at this time
s m g i by clicking Yes, | have a new Registration Code" and following the on-
Eﬁ%’i’:m“ screen instructions. The Registration Code appears on the yellow piece
W of paper below the Unlock Code.

If you would like to register your product later, click ‘No, I will register
my product later" and click Next. You can now close the UnlockWizard
] and use MapSource.

UnlockWizard Options

Ere e 25 churucter urkack oo |t bt st

_om [ ] o= |

10 Enter 25-character Unlock Code



Entering an Unlock Code with a Coupon Code
Your MapSource product may contain a tri-fold document, called an Gettmg Started

Unlock Certificate, that contains an 8-character Coupon Code. If so, use this

code to unlock your MapSource product using the instructions that follow.

NOTE: You need to connect to the Internet to complete this proce- UnlockWizard

dure. During the procedure, the UnlockWizard will attempt to con-
nect to the Internet if you are not already connected. Take proper

steps to complete the connection, if necessary. L2
D s haww w 25-charactan unkack code
To unlock your product with a Coupon Code: P
7 [k e 15 g s ok code |
1. Open the UnlockWizard if it is not already open (see p. 9). S
2. Click 'No, I need to get a 25-character unlock code.” Click Next. bl
. . . T Bachup wy unkock codes b1 e
3. Enter your personal information, such as name and address, in the B e
fields provided and click Next.
4. Enter your Garmin Customer Code and click Next. If you do not have
a Garmin Customer Code, follow the directions on the screen. Your e |
registered Garmin products will appear in a dialog box. Click Next. _ _
5. To redeem your Coupon Code, click ‘I have an Unlock Certificate, | will UnlockWizard Options
type itin" and click Next. i

Erde tom Coupon Cocke oay vemse v 12 vkemrs.

6. To complete this screen you need either your GPS unit's internal Unit ID
or Serial Number. To get the Unit ID, follow the appropriate steps in the
UnlockWizard. To enter the unit’s Serial Number, find the number on
the back of the unit's casing and enter it in the space provided.

The by ks o an Linkock Cenficale vath he Crugon Dode:

7. Enter the 8-character Coupon Code found on your Unlock Certificate.
Click Next.

8. Select and verify the regions that you would like to unlock. After
checking the box to agree to the terms, click Next to complete the
unlock process. Your product is now unlocked. 2

Enter Coupon Code 1




Backing up and Restoring Your Unlock Codes

Getti ng Started Keep your Unlock Codes in a safe place by backing them up to a file and
storing that file in a safe location. You can restore the Unlock Codes from
the saved backup file.

UnlockWizard To back up all Unlock Codes into a saved file:
1. Open the UnlockWizard if it is not already open (see p. 9).
2. Click ‘Backup my unlock codes to a file." Click Next.

= 3. Inthe Save As dialog box, select the folder where you want to store
bt your unlock codes.

rﬁ:‘i‘:ﬁn'““‘“‘:‘:“‘“"" é NOTE: We recommend that you keep the back up file in a sepa-

S A rate location other than the MapSource folder.
11 o e o g G v Costrrnss . .

e i o 4. Enter a file name for your unlock codes and click Save.

e o st bamain 5. The UnlockWizard saves all of your unlock codes into that file for
future use. Select 'Yes' to return to the UnlockWizard Options menu or
select ‘No, I am done’ to exit the UnlockWizard.

o= |

UnlockWizard Options

|| =
*|  Cancel

Swvmmime [Unkoch Code Fies [ uni)

Windows ‘Save As’ dialog box
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To restore your Unlock Codes from a saved file:

1.
2.
3.

Open the UnlockWizard if it is not already open (see p. 9).
Click ‘Retrieve and reinstall all my Garmin unlock codes.” Click Next.

If you have backed up your unlock codes to your PC using the steps
described previously, select ‘Retrieve my codes from a file on my PC.'

Browse for the file you saved your unlock codes in and click Open.

Your codes should now be restored to MapSource. Select Yes' to return
to the UnlockWizard Options menu or select ‘No, | am done’ to exit
the UnlockWizard.

To restore your Unlock Codes from the Garmin Server:

NOTE: You need to be connected to the Internet to complete this
procedure. During the procedure, the UnlockWizard will attempt
to connect to the Internet if you are not already connected. Take
proper steps to complete the connection, if necessary.

Open the UnlockWizard if it is not already open (see p. 9).
Click ‘Retrieve my unlock codes from the Garmin Server.” Click Next.

The products you have registered through the Garmin Web site using
your Customer Code are listed. Click Next.

Your codes should be restored to MapSource. Select 'Yes' to return to
the UnlockWizard Options menu or select ‘No, | am done’ to exit the
UnlockWizard.

Getting Started

UnlockWizard

Dot v 25 charscter urikack oo

Ve, | have a Torchasacha snloch code
Sttt i you harm .25 chasacier uricck cocks ared
irou Wt oo e r jou

M e o g0 et unkock ode
bk aghon § you ward s redes an chascie copm
‘=2 o urkock a tacarel G e o puachans - adiea
ek codds g yeas ol cind

11 g e e i s Costrrns
7 ekiers andreaial ol vy Garmey i cdee]
T Backug vy riack codes bo 1 e
T Vinwy oy retabed riack codes
T Update g Garwn sccouns dmaion.

_om [ ] o= |

il

UnlockWizard Options

. 2

Code. ¥ you v encouies soss Sisase coniact e farmin Product
Support o 1-000-H00-1(60).

_om [ ] o= |

Retrieved Unlock Codes from Garmin Server
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Viewing your Installed Unlock Codes
Getti ng Started You can view your installed unlock codes at any time using the
UnlockWizard.

To view your installed Unlock Codes:

UnlockWizard 1. Open the UnlockWizard if it is not already open (see p. 9).
2. Click 'View my installed unlock codes.” Click Next.

e ' 3. The UnlockWizard then displays a list of all of the unlock codes for
el s ) your Garmin GPS units and mapping products.

irou Wt oo e r jou

Vot o o To view the properties of a particular region or product, highlight the
e product and then click Properties.

o o b To delete a particular region or product, highlight the product and

T Backip v ukock coes 10 e

Bk click Delete.

e
UnlockWizard Options

Rugen [ Cormrurt
iy vk

List of installed unlock codes
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Updating your Information with Garmin
You can update your personal information on file with Garmin at any Gettmg Started
time using your Garmin Customer code and the UnlockWizard.

To update your information with Garmin:

1. Connect to the Internet. UnlockWizard
Open the UnlockWizard if it is not already open (see p. 9).

x|
Enter your Garmin Customer Code. Click Next.

Doyt e 25 characto urkack cose
7 Ve, | haoe & Frchesatie sk code.
Skt thi sk § o b 25 chasacn kot ok ared
irou Wt oo e r jou

2
3
4. Review the products registered in your name and click Next.
5

M rensd o g 25 chacte rtock oo
Seact thus apton § you wank in desm an i-characies coupan.
‘cade o unkock @ mecard Garen Uk o puchens s sddaone
urich code wng vou aedl cand
11 o e o g s v Costrrnss
T Netvres art reewtal of vp Gavwn unkock codes.
T Bachup i unkock codes b1 e
¥ Mooy antoked rfock ol
1+ ipdfe vy Garvin oo nismain

The Garmin Web site opens in your browser. Review your personal
information and make any adjustments as necessary. Click Continue.

6. Garmin updates your personal information.

NOTE: You need to be connected to the Internet to complete
this procedure. During the procedure, the UnlockWizard will at-
tempt to connect to the Internet if you are not already connected.
Take proper steps to complete the connection, if necessary. —=
UnlockWizard Options

Registering your Product o
After you have unlocked your MapSource product with the
UnlockWizard, you can register it with Garmin. Follow the Unlock-
Wizardss directions to register your product. When prompted, enter the
Registration Code that appears near the Unlock Code on the yellow sheet of

paper that came with your product.

NOTE: You need to be connected to the Internet to register your
product. During registration, the UnlockWizard will attempt to
connect to the Internet if you are not already connected. Take
proper steps to complete the connection, if necessary.

Erbe e T-churctms Ragriaton Coce.

snibe Tound iy [
brladion  pece of pape: 1wy WP TANT i 8 dfesend
Lgunge. G o Fgpa b

IMPORTANT!

e T [ |

Enter your Registration Code
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Using the InstallShield Wizard

Getting Started You can repair or remove the MapSource program with the
InstallShield Wizard at any time. You can also modify the regional cover-
age areas of some MapSource products.

InstallShield Wizard To access the InstallShield Wizard:
1. Click the Start button, Settings, and then ‘Control Panel.’

2. From the Control Panel page, select ‘Add/Remove Programs.’
3. Highlight ‘"MapSource” and click Change/Remove.
4. The InstallShield Wizard opens.

Wiskeome
Moy, e o imove e progin,

— Some installations of MapSource may provide a link to the InstallShield
PIE Wizard in the Start menu. If you have this link, you can access the
o InstallShield Wizard using the following procedure.
- 1. Click the Start button.
"r%f'a.........‘_ 2. Select Programs, then MapSource, then '<MapSource product>
e (] e Installation Wizard.
InstaliShield Wizard Modifying Coverage Areas

Jor North American Ciy Select Some MapSource detailed map products allow you to modify the

regional coverage areas. If your MapSource product allows this, Modify’
appears in the InstallShield Wizard as an option.

To add or remove specific coverage areas:

1. From the InstallShield Wizard screen, select ‘Modify," and click Next.

2. On the Regional Coverage Area Selection page, check or uncheck
the boxes next to the areas you want to add or remove and click Next.

A NOTE: You will need your MapSource CDs to modify or repair
MapSource.

16



Repairing MapSource

Use InstallShield Wizard’s ‘Repair’ option to duplicate the previous in- Getti ng Started
stallation of the mapping product if it becomes corrupt. The InstallShield
Wizard will step you through repairing your MapSource.

NOTE: You will need your MapSource CDs to modify or repair InstallShield Wizard

MapSource.

Removing MapSource
Use InstallShield Wizard’s ‘Remove’ option to remove the MapSource
application from your system.

To remove the MapSource application from your system:

1. Open the InstallShield Wizard (see p. 16).

2. Select 'Remove.’

3. The InstallShield Wizard removes the MapSource application from
your computer.

A NOTE: If more than one detailed map product is installed and you
only wish to remove one product, open the InstallShield Wizard
for the product you wish to remove.

17
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Getting Started

GPS Connections

Y

Serial Communications Port

USB Data Port

Connecting Your GPS Unit to a Computer

You can connect your Garmin GPS unit to your computer using a DB-9
serial communications port or a USB data port. (Keep in mind that not all
GPS units are USB-compatible.) If your GPS unit uses a USB, specific drivers
are required (see “Information about USB Drivers” below for more
information).

To connect your GPS unit to your computer:

1. When using a PC Interface Cable, connect your GPS to a serial
communications port on your computer (see illustration at top left).

When using a USB Data Cable, connect your GPS to an available USB
data port (see illustration at bottom left).

2. Make sure your GPS is turned on and the Serial Data Format is set to
‘Garmin," if possible.

To verify proper connection to the computer:
1. In MapSource, click Utilities and then ‘Get Unit ID.’

2. Make sure the name of your GPS unit appears in the 'Device’ field.
If not, your GPS unit may not be connected properly. Check the
connection and then click Find Device if it does not appear.

Information about USB Drivers

The USB drivers should have been installed automatically when you
installed the MapSource program. When you initially connect a USB GPS
device to a USB port, your computer may prompt you to locate the destina-
tion of the drivers for the USB GPS. You only need to install the drivers
once. After the drivers are installed, MapSource will always detect your USB
GPS unit when you connect it to the computer.



User's Interface

MapSource Interface

Toolbars

Data Tabs

Menus

‘& Untitled - MapSource
File Edit Find Transfer Wiew Tools

| nil@lsl] «[e[mlp]o] ] | alw]a]
Maps | waypoinis | Routes | Tracks| GPs_D E :
IAlea Siz : ‘
o

Marme / |

4 i =

0 Mapls] - 0 KB |

= nclude raute calctstion data; | ¢ . :

[Fecammended if yaur GRS supparts suta-rautits| W - YIS EI =

741: |48
R R P
Vv
5l N | —

IS |nelude terrain shading data,
[Fecammended it vour GRS supports termain shi i
Map SelName:l B
a1 i
Forsmsgelect=d  |Latilon hddd"mm‘mmm‘(WGSﬁ‘}) |45 05,791 W93 26,458 [Erocklvn Park, Minnesata, Morth American City Navigator vS.0, 2, 43 ME—— \
Graphic Map

Splitter Bar Status Bar
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Graphic Map

The Graphic Map displays the “basemap” and any “detailed maps” you
User’s Interface have installepd‘ A baspemag ir?cludes major rI:)ads and }éities, whereaspdet};ﬂed
maps show points of interest, addresses, and smaller streets and intersec-
Graphic Map and Status Bar tions. As you zoom in on the Graphic Map, you will see more detail. Look
at the zoom level in the lower right-hand corner of the map. When you see
the message ‘GPS Map Detail,’ you have zoomed in enough to view detailed
maps. As you zoom out, you will see the basemap, which shows less detail.
To learn how to move around the Graphic Map and zoom in and out, see
“Moving Around the Graphic Map,” p. 42.

Status Bar
The Status Bar extends across the bottom of the MapSource window (see
p. 19). The Status Bar may show the following information:

o The number of items highlighted in the list under any tab.
o The current Position Format and Map Datum for the map.
¢ The latitude and longitude of the mouse pointer on the map.

¢ The name and approximate data size of any map section you point
to with your mouse on the Graphic Map (if you are using the
Map tool).

o The distance and bearing from a beginning point to a place you
point to with your mouse on the Graphic Map (if you are using the
Distance/Bearing tool).

If you do not see the Status Bar, choose ‘Show Status Bar’ from the
View menu.
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Data Tabs

The Data tabs (Maps, Waypoints, Routes, Tracks, and GPS) are located
on the left side of the MapSource window (see p. 19). When you select
maps or create waypoints, routes, or tracks, you see that data listed under
the appropriate data tab. For example, when you select maps to save to your
GPS unit, these maps are listed under the Maps tab (see “Adding, Removing,
and Using Map Sets,” p. 44, for instructions).

The data you see listed can be data you create in the Graphic Map or
data you have transferred to MapSource from a GPS unit. You can easily
view or edit items listed under each tab. You can also sort the data by col-
umn. Click a column header, such as Name’ or ‘Area,’ to sort the data list by
that column. An arrow appears showing the direction of the sort (ascending
or descending). You can also change the order of the columns by clicking
and holding a column header, then “dragging and dropping” the column to
a different location.

You may need to move the Splitter Bar to see all the column headers.
Click and hold the left mouse button on the bar and then drag it to the left
or to the right.

User's Interface

Data Tabs

“2: uUntitled - MapSource
File Edt Find Transfer Wiew Tools Lkiities Help

| ol=(a|s| L%I%IEIXIOIOIH o |a] |

Name _# [ Awea [ sk

4] |
OMapls)- 0B

= Include aute cofculafion data
[Resammentecffyour GPS suppers auorouti

Incllcle (eein sheding data

e o [ s e i i T S pm——
Map Set Narne: -
O1tems Selected  [Laf/Lon hddd®mm. mmm(wiGS A4} [
Data Tabs Splitter Bar
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File Menu
New— Opens a new MapSource document with empty data tabs.

User's Interface

Open— Opens a previously saved MapSource document.

Save/Save As— Saves the current MapSource document.

Menus and Toolbars Print— Prints the current Graphic Map display.

File Menu Print Preview— Shows a preview of what will be printed. To print the
Hew Eo preview, click the Print button that appears on the preview page.
Open. .. ctr:+o Print Setup— Opens the Setup page for printing the MapSource
Save Cerl+5 ; ;
e Graphic Map display.
_ Send Mail— Allows you to send an e-mail with the current MapSource
Print... CEr+P

B document as an attachment. The recipient must own the same ver-
Print Setup. . sion of MapSource you are using or a newer version. Older versions of
MapSource cannot open newer MapSource documents.

Send Mail. ..
Import. .. Import— Allows the user to open data stored using .mps format or
Erntiee Garmin PCX5 format. MapSource displays waypoints (.wpt), routes

(1te), tracks (.trk), or one of the maps (.grm) provided with PCX5.

l.ﬁ.ctive_TrackLog.gdb\ Recent
Zflight 3-12-04.mps— | Files

Export— Allows the user to export MapSource data in tab-delimited
Exit text format (.txt for use in a word processor or spreadsheet), in .dxf
format, or in .mps format.

File Toolbar Recent Files— Shows the four most recently opened MapSource docu-

New Document Save Current Document ments. To reopen one of these files, click the document name.

Exit— Closes the MapSource application.

| b|z|=|3|

Open a Document Print Graphic Map
22



Edit Menu
Undo— Cancels the last action you took or command you gave.

User's Interface

Redo— Reactivates the last action you took or command you gave
(available only after you have performed an Undo).

Cut, Copy, Paste— These functions work like many other Windows Menus and Toolbars
programs. You can cut or copy and paste any MapSource information

listed in the data tabs from one MapSource document to another, or from Edit Menu
MapSource to a word-processor, text editor, or spreadsheet in tab-delim- Undo Ctrl+2
ited format Redo Chrl+Y
Delete Item— Deletes waypoints, routes, tracks, or maps selected in the Cut Chrl+
data tabs or on the Graphic Map. Copy s

o ) ) Paste Chrl+V
Select All— Highlights all data in the active data tab and on the Delete Ruiite Del
Graphic Map.

Select All Chrl+-A
New Waypoint— Automatically creates a new waypoint in the center :
of the Graphic Map and displays the Waypoint Properties dialog box. xew :"aipo'”t”' Etr::;v
. . . . e POUCE, ., Fi

Use this option ti) create and format anew waypoint. For more detailed e il
information, see “Creating Waypoints,” p. 54. Duplicate Rolite
New Route— Displays the Route Properties dialog box. Use this op- Remove Waypaink from Route - Chrl+Del
tion if you want to find a place and then route to it. For more detailed IS
information, see “Creating Routes,” p. 62. Prefarences, .. CEtl-4+ShiFt-HP
Duplicate Route— Duplicates the route that is currently selected. The Edit Toolbar
new, duplicated route will be saved as the old route name followed by a ,
number, as in “Route 1.” Cut aste Undo

Remove Waypoint(s) from Route— Removes a selected waypoint

by 3
from the selected route. & || 8| x|

Properties— Opens the Map, Route, Waypoint, or Track Properties

dialog box, depending on the data item that is selected. Copy Delete Redo
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User's Interface

Menus and Toolbars

Preferences Dialog Box

Time ind Rauting
Displyy | Units | Pesion | FieLocation | Wappoint | ‘waypoint Categories

Map Detsi
[ Lo ————————————— | High

Semices  |Auto - Light Sectors [On B
Spot Soundings  [on - Tenain Shading [0t =

Change Map Font

oK | Cancel Apply
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Edit Menu: Preferences

Use the Preferences dialog box to customize MapSource features and
settings. When you change any settings, click Apply to see the changes take
effect immediately or click OK to apply the changes and exit the Prefer-
ences dialog box.

A NOTE: If you leave all preferences at their original settings,
MapSource still functions correctly for general use.

Display Tab: Use the slider bar to control the amount of map detail you
want to display on the Graphic Map (this setting does not change the
amount of map detail transferred to the GPS unit from your computer). The
map may take longer to redraw if you select a high level of detail. Select
‘High’ when you have focused on a small area of the map and are ready to
view lots of detail in that area. You can also choose options for displaying
‘Services, ‘Spot Soundings’ (for Blue Chart users), ‘Light Sectors’ (for Blue
Chart users), and ‘Terrain Shading,” on the Graphic Map. To change the font
of the labels on the map, click Change Map Font.



Units Tab:

Distance/Speed— Select Metric, Nautical, or Statute. All distance or I
speed measurements reflect this setting. User’s Interface

Heading— Choose one of the following;

Menus and Toolbars

¢ True—displays true North headings.

* Automatic Magnetic Variation—automatically calculates the

magnetic variation for the geographical area. Preferences: Units Tab
o User—allows you to enter a magnetic variation.
Grid—provides a true North heading as determined by the g | i | FEHES
Display  Utits | Postion | FilsLocation | ‘Waypcint | ‘Waypoint Categories

Position Format.
Distance & Speed: |EENCR ~

¢ Cardinal Direction—displays your heading and/or course as N

Heading. [True =
(North), S (South), E (East), and W (West). e EI—
Altitude/Elevation— Select Feet or Meters. Depty [Feet |
Area; |Square Feet, Square Miles ol
Depth— Select Feet, Meters, or Fathoms. : e
e |

Area— Select Acres, Hectares, Square Feet, Square Miles, or Square
Meters, Square Kilometers.

Temperature— Select Celsius or Fahrenheit.

Ok | Cancel Apply

Position Tab: Select from the available default grid formats or manually
enter information for a user-defined grid.

NOTE: You should not need to change Position settings unless

you are familiar with grid formats and map datums.

Grid— Select a grid format from the drop-down list.

Datum— Select from over 100 available map datums or manually enter
information for a user-defined map datum.

25



File Location Tab: Sets up a default location on your computer for saving
and opening your MapSource files and importing and exporting data.

I
User’s Interface Manually enter the location or click ‘Browse’ to select the folder for your
default file location.
Menus and Toolbars Waypoint Tab: Sets up preferences for creating waypoints in MapSource.
yp pp g wayp p

Limit names to— Use the drop-down menu or manually enter a num-

. ber to limit the number of characters in waypoint names.
Preferences: Waypoint Tab
When I Create a Waypoint on a Map Feature— If you want to use

e 2 your own settings, enter your information for ‘Name Prefix,” ‘Symbol,
SR |Timfms | — | — | Db it | and ‘Display,” and then check the ‘Use the choices above’ option. Other-
e e e e wise, MapSource will use default settings.
i st | ERNER e Waypoint Categories Tab: A special feature that allows you to set up your
T — own personal system for organizing saved waypoints in user-named catego-
Exanrle Nae: 001 ries. Enter the category names here; the Categories list appears when you
o E create a new waypoint (see p. 56).

Display:  [Symbol & Name =
R e Time Tab: Sets up displayed time either by the computer’s local time zone

£l testei or by entering a Universal Time Conversion (UTC) offset.

% Let application decide its name, symbol and display

Find Tab: Allows you to set the maximum number of places MapSource
[oc ] cocol | ooy should find during a search and how many ‘Recently Found’ places you
want MapSource to remember. You can also set the number of auto-com-
plete suggestions you want to appear when you are searching (see p. 57).
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Routing Tab: Sets up preferences for calculating routes. See “Routes,” p. 62
for more information.

User's Interface

Route Style— The original (default) setting is ‘Use Auto-Routing,” which
means MapSource will calculate turn-by-turn directions over roads to a

location. Choose ‘Use Direct-Routing’ to calculate straight-line directions (no Menus and Toolbars
roads) if your GPS unit does not support Auto-Routing.
é NOTE: The aqdmonal options below apply to auto-routing users. Preferences: Routing Tab
If your Garmin GPS does not support auto-routing, you cannot
change these options. =
Display | Urits | Posion | FieLocation | ‘wappoint | “aypoint Categaries |
Calculation Style— Determines how MapSource calculates routes. Tire | Fi g
Routes using Faster Time’ are faster to drive but may be longer in F}L  r———— ‘
distance. Routes using ‘Shorter Distance’ are shorter in distance but may a5 Diting Speed
. . i et pou average divin o
take more time to drive. L vy marngndiy ot |
. 5 . . . Interstate Highwaps: 67 3:
Vehicle— Allows you to take advantage of MapSource’s built-in routing eick: [Fartiotmde =] | (o &=
information to optimize routes for your vehicle type. For example, a e ] v e [ =
street may be accessible by emergency vehicles only, or a residential ™ Tol Floade Colecor Road: '35__::{ =
: ™ Unpaved Roads Residential Streets: Eli
street may not allow commercial traffic. EE

Try to Avoid— Allows you to avoid certain road types, such as high-
ways, toll roads, unpaved roads, or U-turns. MapSource uses these road E ]
types only if alternative routes take you too far out of your way or if no

other road is available.

Cancel Apply

Driving Speed— Allows you to enter your average driving speeds for
use in calculating driving time. Click Reset to return to original settings.
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Find Menu
Find Places— Allows you to search for a city, feature (point of interest),

User’s Interface address, street, intersection, or waypoint and view it on the Graphic
Map. You may have fewer search options; the MapSource product you
Menus and Toolbars own determines what types of features you can search for. Keep in mind
that Find Places only locates places within the regions included on your
map.
Find Nearest Places— Allows you to find features near the center of
Find Menu the Graphic Map. If you right-click on any location, feature, or waypoint
Find Flaces. .. Chrl+F (including waypoints in the Waypoints tab list), you can search for
Find Mearest Places...  Ctrl+Shift+F features near that location on the map.
Recently Fournd Places. ..

Recently Found Places— Allows you to view places you have searched
for recently.

Find Toolbar

[al#l&

Find Places Find Nearest Recently
Found
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Transfer Menu
Send To Device— Allows you to transfer maps, waypoints, routes, and ;
tracks to a GPS unit or storage card. See “Transferring MapSource Data,” User's Interface
p. 47, for more information.

Receive From Device— Allows you to transfer maps, waypoints, routes, Menus and Toolbars
and tracks from a GPS unit or a storage card to your computer. See
“Transferring MapSource Data,” p. 47, for more information.

A NOTE: Garmin GPS units can store a limited number of maps,
waypoints, routes, and tracks. Please refer to your GPS unit

Transfer Menu

owner’s manual or the Garmin Web site (http://www.garmin.com) Send To Device. ..
to find out how much memory your GPS unit has to store BTN E TR T BT e
this information.

Transfer Toolbar

B ﬂ
[~ Device Settings —————————————————————— [ Dewice Setbings f
I wou don't see wour device listed below, 1F you don't see your dewice listed below,
connect it ko the computer and turn it on, connect it to the computer and turn it on,
then click Find Device, then click Find Device,
Find Device [ Find Bevics ™
Receive From Send To
Device: [eTres Smmit (COM1) = Devics: [eTrex Summit (COM1) & ) :
Device Device
WhatToReceive What To Send
I7 | Maps ¥ Routes il I=Eoites
o [ Tiacks ¥ Waypoints ™ Tiatks
s : Send Caneel
Receive From Device Send To Device
Dialog Box Dialog Box
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View Menu
Show Selected Item on Map— Shows any highlighted item from the

I
User’s Interface data tabs (a map, waypoint, route, or track) in the center of the Graphic
Map. The menu heading changes according to context; for example, if
Menus and Toolbars you highlight a waypoint from the Waypoints tab, the menu will read
‘Show Selected Waypoint on Map.’
View Menu Go To Position— Allows you to enter a latitude/longitude position to
Show Selecked Map On Map  Chrl+D view on the Graphic Map.
G0 To Position. .. Chrl+T Zoom In— Decreases the zoom scale, showing a smaller area in more
detail. You can also press Plus (+) on your keyboard to zoom in.
Zoom In % i )
Zoom OUt : Zoom Out— Increases the zoom scale, showing a larger area in less
detail. You can also press Minus (-) on your keyboard to zoom out.
Zoorn In Max Chrl +
Zoom Out Region Chl - Zoom In Max— Decreases the zoom scale to the smallest setting, show-
ing the most detail.
Hide GPS Map Detail Ctrl+G Zoom Out Region— Increases the zoom scale to center on the region
Shaw Crosshalr Ctri+H that is currently selected.
Switeh to Product ' Hide/Show GPS Map Detail— Hides or shows a fully detailed version
hengeblon e d of the Graphic Map, including all available map information. Uncheck-
T aalb e » ing this option enables faster map drawing.
Hide Status Bar Show Crosshair— Redraws the map display to show a crosshair in the
center of the Graphic Map.
View Toolbar

&|&|[zom =]

/

Zoom In
30 Zoom Out Zoom Scale



Switch Products— Allows you to select a MapSource product to
display on the Graphic Map if you have purchased more than one

from Garmin. You can choose from any MapSource products that you
have installed on your computer and unlocked (if required). For some
MapSource products, you may need to insert the product CD into your
computer’s CD-ROM drive. If so, a message will prompt you to insert the
proper CD.

Select Product

JIMetroGuideUS.ﬂ\vS = 'E{l'a\llmmi |

If you have more than one MapSource product installed, you
will see the Select Product drop-down menu, which allows
you to switch between MapSource products. If you have only
one product installed, you will not see this menu.

Change Map Scale— Allows you to select a zoom scale from a list. The
options are the same as the Zoom Scale on the View Toolbar.

Show Toolbars— Allows you to choose which toolbars (File, Edit,
View, Transfer, Find, and Tools) you want to display. A check mark
next to the toolbar name means that toolbar will appear. You can also
‘Hide All' or ‘Show All’ toolbars.

Hide/Show Status Bar— Allows you to hide or show the Status Bar at
the bottom of the MapSource window. When this menu item is checked,
you will see the Status Bar.

User's Interface

Menus and Toolbars

@ll@l“zum -]

\

Zoom Buttons Zoom Scale

Using the Zoom Scale, you can zoom in to 80 feet and out to 1500
miles. Click the zoom buttons to zoom incrementally.
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Tools Menu
Map Tool— Allows you to add or remove maps from a Map Set. See
“Map Sets,” p. 44, for more information.

User's Interface

Zoom Tool— Allows you to zoom quickly to a specific area on the

Menus and Toolbars Graphic Map.
Hand Tool— Allows you to pan or move around the Graphic Map.

Selection Tool— Allows you to select map features, waypoints, routes,

Tools Menu

and tracks directly on the Graphic Map.

it m Waypoint Tool— Allows you to create waypoints on the Graphic Map.
v aom 3 Sge}i‘\?}iaypoints,’i p. 54,1f0r more information about creating waypoints

Hand b with the Waypoint tool.

Route Tool— Allows you to create a new route on the Graphic Map by
Waypaink " using existing waypoints or creating new waypoints. See “Routes,” p. 62,
Rote r for information about creating routes with the Route tool.
Selection = Distance/Bearing Tool— Allows you to measure the distance and bear-
Distance/Beating d ing from one point to another on the Graphic Map.

Tools Toolbar
Tools Keyboard Shortcuts

Distance/
Map Hand Route Bearing You can select and switch between tools by using key-
\ \ board shortcuts. With the Graphic Map selected, press
\ \ // the appropriate key on your keyboard to switch tools:
J Gllt{ %’?l Pl}l'&,l [Fm Zoom— g Route—r
L Hand— h Map—m
/ ) ) Selection— s Distance/Bearing— d
Zodm Waypoint Selection Wi .
aypoint— w
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Utilities Menu
Unlock Maps— Opens the UnlockWizard so that you can unlock map
data if your software requires an unlock code. Use this menu option if
you chose not to unlock maps during installation, if you want to unlock

another MapSource region, or if you want to unlock maps for a second Menus and Toolbars
Garmin GPS unit. See “Unlocking Maps,” p. 8, for more information.

User's Interface

Get Unit ID— Retrieves the Unit ID of your GPS unit. Connect your
GPS unit to an available serial port or USB port on your computer. Make Utilities Menu

sure the name of your GPS unit appears in the ‘Device’ field. If not, click e
Find Device. Then click OK to get the Unit ID. If your GPS unit does e

not appear in the ‘Device’ field, check to make sure that it is connected Get Uit ID. .

securely to your computer and that it is turned on. Rename GRS, .,

Erase Garmin Storage Card— This option is only visible if you have et PC Clock, .,

a Garmin Data Card Programmer installed and connected to your PC.

Select this option to completely erase the contents of your Garmin

data card. Data card contents cannot be recovered if erased. Set PC Clock

Rename GPS— Allows you to give a new name to GPS units that con- ]
nect to your computer via USB port and some that connect via serial [ R o
port. This option is helpful if you connect more than one GPS unit to e Cance
your computer because it allows you to differentiate between GPS units

when you are receiving or sending information. eviei [rino 20 com) 7]

Set PC Clock— Allows you to synchronize the clock on your PC with e o e

the clock on your GPS unit. Connect your GPS unit to a serial or USB il s

port on your computer. Make sure the name of your GPS unit appears in
the ‘Device’ field. If not, click Find Device. Then click OK to set the
PC Clock.

A NOTE: Not all Garmin GPS units may be used to set your
PC clock. 33




Help Menu
Contents— Displays the Help Contents tab.

User's Interface

Index— Displays the Help Index tab.

About MapSource— Displays information about the MapSource ap-
Menus and Toolbars plication, including software version, USB driver versions, and a list of
installed products.

Go To MapSource Update Web Page— Opens the MapSource

Help Menu
Updates and Downloads page of the Garmin web site so you can check
el for the latest available version of MapSource software to download. To
e update MapSource, click ‘Download’ and follow the directions on your
Abouk MapSource. ., computer screen.
&0 To MapSource Update Web Page NOTE: MapSource is the operating software for all of our
software products (such as BlueChart or City Select). Installing a

newer version of MapSource will not update your map data.
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Right-Click Menus

MapSource includes shortcuts to many functions of the main menus
through right-click menus. To access a right-click menu with any tool
(except the Zoom tool), click the right button on your mouse anywhere on
the Graphic Map, and a menu of options appears for that feature or location.
Right-click on an item in one of the data tabs to open a menu for that item.

If you right-click on a part of the map where there is more than one
feature (such as a waypoint that is part of a route), you see a list of all the
features at that location. Click a feature in the list to show the appropriate
right-click menu.

and ‘Find Nearest Places’ options are default right-click options.
You can access them by clicking the right mouse button anywhere
on the Graphic Map.

NOTE: The ‘New Waypoint,” ‘Begin Route,” ‘Begin Measurement,”

Map Feature Right-Click Menu

If you right-click on an open area or a feature of the Graphic Map (such
as a Point of Interest, Exit, Fishing Area, or Navigational Aid—not a route,
waypoint, or track), you may see the following menu options:

New Waypoint— Creates a new waypoint at that location and opens
the Waypoint Properties dialog box.

Begin Route— Activates the Route tool 3=/ and starts a route at
that location.

Begin Measurement— Activates the Distance/Bearing tool &, which
allows you to measure the distance and bearing from the location you
selected to another location on the Graphic Map.

Find Nearest Places— locates features nearest that point.

User's Interface

Right-Click Menus

Map Feature - "0'Connar's Pub'

Map Feature - "Kiki's Bonton Maison”
bap Feature - ‘“Westport Ad"
Wayppaint - "OCOMMORS"

Route - "NWPHTG to HUMMWE'

When you click the right mouse button on a location
that has multiple features, the first menu shows a list
of all those items. Select one of these items and the
appropriate right-click menu will appear.

Right-Click Menu

Mew Whaypoink, ..
Eeqin F.oute
Eeqin Measurement

Find Mearest Places, .,
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User's Interface

Right-Click Menus

Map Feature Right-Click Menu

Mew Waypoint, ..
Eeqin Route
Eeqin Measuremment

Find Mearesk Places, .,

‘Show ©n Map
Feature Properties. ..

Show on Map— Shows the selected map feature in the center of the
Graphic Map.

Feature Properties— Activates the Properties information box for the
selected map feature. The box may contain the address and phone num-
ber of a point of interest, US Interstate Exit Service information, Fishing
Hot Spot or Lake information, or details about a Marine Chart.

Predict Tides— If your MapSource product supports this feature, click
the Selection tool, right-click the Tide Station, select the Tide Station
Name from the menu, then select Feature Properties.” In the Tide Pre-
diction dialog box, you can also view the tide information for a different
time or date, view the information either by day or by week, and view
information using the local station time.

Show This Map Only/Show All Maps— This feature applies to
BlueChart regions of MapSource, where map areas frequently overlap.
With the Map tool selected and a map area highlighted in yellow, right-
click the map area to access this additional option. Select ‘Show This
Map Only’ to view detail only within the selected map. To cancel, right-
click the map area again and select ‘Show All Maps.’

Tide Prediction Dialog Box
Wik 22 PR LR _'-_I

Tiee
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Waypoint Right-Click Menu
If you right-click on a waypoint listed in the Waypoints tab or on the

Graphic Map, you may see the following options:

Move Waypoint— Activates the Selection tool and allows you to move
the waypoint to another location on the Graphic Map.

New Waypoint— Creates a new waypoint at that location.

Begin Route— Starts a new route at that location.

Begin Measurement— Starts a new measurement from that waypoint.
Find Nearest Places— Locates features near that waypoint.

Remove Waypoint From Route— Removes the selected waypoint from
a route but does not delete the waypoint (this option is enabled only if
the selected waypoint is part of a route).

Cut/Copy— Just like the functions in the Edit menu, these options
allow you to cut and copy waypoints from one active MapSource docu-
ment to another.

Delete Waypoint— Deletes the selected waypoint.

Show Selected Waypoint on Map— Shows the selected waypoint in
the center of the Graphic Map.

Waypoint Properties— Opens the Waypoint Properties dialog box,
which allows you to review and edit properties of the selected waypoint.

User's Interface

Right-Click Menus

Waypoint Right-Click Menu

Move Waypaink

Mew \Waypaoint. .
Beg_in Rouke
Beqin Measurement

Find Mearest Places. .,

Remove Waypoint from Route

Cuk
Copy
Delete Wavpoint

Show Selected Wavpoint On Map
‘Waypoint Propertties. ..
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User's Interface

Right-Click Menus

Route Right-Click Menu Options

Insert Route Section
Duplicate Route
Imvert Route
Recalculate Route

Mew YWaypoint. ..
Begin Route
Begin Measurement

Find Mearest Places. ..

Zuk
Copy
Delete Route

Showe Selected Rouke On Map
Route Properties, .

Route Right-Click Menu

If you right-click on a route listed in the Routes tab or on the Graphic

Map, you may see the following options:

Insert Route Section— This option appears when you select a route
and then right-click a leg of that route (between two waypoints). It al-
lows you to insert a new point in that leg of the route.

Extend Route— This option appears when you right-click the start
point or end point of a route. It allows you to extend the route to include
an existing waypoint or map location.

Replace Route Section— This option appears when you select a route
with at least three waypoints and right-click one of the waypoints. It
allows you to move the waypoint to a new location.

Duplicate Route— Creates and saves a duplicate route in the Routes
tab. The new route will be saved as the old route name followed by a
number, as in “Route 1.”

Invert Route— Reverses the waypoint order so that the last waypoint in
the route becomes the first, and so on. This command also reverses the
route name if the route name is the Autoname default ‘<begin point> to
<end point>.

Recalculate Route— Recalculates the selected route and includes any
changes; for example, if you have modified the auto-routing prefer-
ences, the new route will reflect those changes. Use this option to create
an auto—route from a direct route (a route created with a non-routable
MapSource product).

New Waypoint— Creates a new waypoint at that location.
Begin Route— Starts a new route at that location.

Begin Measurement— Starts a new measurement from that waypoint.



Find Nearest Places— Locates features near that waypoint.

Cut/Copy— Just like the functions in the Edit menu, these options
allow you to cut and copy routes from one active MapSource document
to another.

User's Interface

Delete Route— Deletes the selected route. nght'c"Ck Menus
Show Selected Route on Map— Shows the selected route in the center
of the Graphic Map.

Route Properties— Opens the Route Properties dialog box, which
allows you to review and edit properties of the selected route.
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Track Right-Click Menu
If you right-click on a track listed in the Tracks tab or on the Graphic

I
User’s Interface Map, you may see the following options:
. . New Waypoint— Creates a new waypoint at that location.
nght'CI ick Menus Begin Route— Starts a new route at that location.

Begin Measurement— Starts a new measurement from that waypoint.

Track Right-Click Menu Find Nearest Places— Locates features near that waypoint.

Cut/Copy— Just like the functions in the Edit menu, these options let
you cut and copy tracks from one active MapSource document
to another.

Mew \Wayvpoint, .,
Begin Route

Beqgin M Ik
AN MeasUremen Delete Track— Deletes the selected track.

Find Mearest Places. . Show Selected Track on Map— Zooms to the selected track and
centers it on the Graphic Map.

Bk Track Properties— Opens the Track Properties dialog box, which

Copy allows you to review and edit properties of the selected track.
Delete Track

Show Selecked Track On Map
Track Properties. ..
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Maps Tab List Right-Click Menu

If you right-click on a map name listed in the Maps tab, you may see the
following options:

Cut/Copy/Paste— Just like the functions in the Edit menu, these
options let you cut, copy, and paste maps from one active MapSource
document to another.

Delete Map— Deletes the selected map from the Maps tab list.

Show Selected Map on Map— Shows the selected map in the center of
the Graphic Map.

Map Properties— Opens the Map Properties information box, which
shows the name, type of coverage area, and size of the map.

User's Interface

Right-Click Menus

Maps Tab List Right-Click Menu

Zuk

Copy
Paste
Delete Map

Showw Selecked Map On Map
Map Properties, ..
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Moving Around the Graphic Map
Before you can use MapSource effectively, you must first learn how to

Reference move around the Graphic Map. Use any of the following methods to pan
and zoom:
Movi ng Around the Gra ph IC ¢+ Select the Hand tool from the View toolbar. Press and hold the
Map left mouse button on the Graphic Map and move the mouse in the
direction you want to move the map. To center on a point on the
- > : lick while pressing Ctrl.
SRR ERE €
| s = ¢ Use the scroll bars on the right-hand side and at the bottom of

the map.

Use the Up, Down, Left, and Right arrow keys on the keyboard.
Hold the Ctrl button down while pressing a directional key to move
a full screen in length.

To zoom in and out on the Graphic Map, you can do the following:
*  (Click Zoom In|®| or Zoom Out | =4 | on the View toolbar.

o Select Zoom In’ or ‘Zoom Out’ from the View menu.

¢ Select the Zoom tool from the Tools menu or press z on your
keyboard. Click the left mouse button once on the map to zoom
in and right click once to zoom out. If you want to zoom in on a
particular area, click and hold the left mouse button and drag the
mouse to draw a box around the area.

ety .
* Mohtpelier 2l
w4t PO

Do | Pattn @ o oo

Use these tools to move around the Graphic Map.

*  Use the Zoom Scale menu on the View toolbar to zoom straight to
a particular level.

¢ Press the Plus (+) or Minus (-) keys on your keyboard. The Plus key
zooms in and the Minus key zooms out.
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Selecting and Measuring on the Graphic Map

You may need to select a waypoint, route, or track on the Graphic
Map to edit or modify it. To select anything on the Graphic Map, use the
Selection tool | i | and click the item you want to select. Selected items
on the map are highlighted in some way. For example, selected routes are
highlighted in yellow.

You may also need to measure the distance in a straight line from one
point to another or the area between several points on the map. To measure
distance and bearing, use the Distance/Bearing tool @ You can also
being measuring by right-clicking on the Graphic Map with any tool (except
zoom) and selecting ‘Begin Measurement.’

To determine a distance and bearing or measure an area:
1. Click the Distance/Bearing tool @

2. Place your mouse at a point on the Graphic Map where you want to
begin measuring and click the left mouse button.

3. Move your mouse to the point where you want to stop measuring and
click the left mouse button. You can see the distance and bearing from
the beginning point to the ending point displayed in the Status Bar.

4. Move your mouse to other end points if you want to continue
measuring. When you select two or more points, you will see the area
encompassed by those points in the Status Bar. When you are finished,
click the right mouse button or press Esc on your keyboard.

Reference

Moving Around
the Graphic Map

Measuring a Distance and Bearing

|Parkersburg
o

A7 mian
GPS hMap Detail

[ ]

_|Distance: 26.4 mi, Area: 31.0 sq mi, Bearing: 0 true, from Mew Harl

In the Status Bar; you can see the total distance between the three
cities and the area between them.
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Adding, Removing, and Using Map Sets
A Map Set is one or more detailed area maps that you have selected from

Reference the Graphic Map and want to save to your Garmin GPS unit. The detailed
areas are determined by the MapSource product you have installed.
Map Sets The names of all area maps in a Map Set appear in a list under the Maps

tab. You can view the name of the map, what MapSource program it came
from, and how much memory you need in your GPS unit to save the map.

Maps Tab You can also view this information by right-clicking on a map name and
Routesl] | Tiacks | GPS choosing ‘Map Properties.”
Maps(4 - , A

- e At the bottom of the Maps tab, you will see the number of maps in the
Name [ e Map Set and how much total memory you need in your GPS unit to store
Ballwin, Mizsouri Morth Amnerica. . . . .
S e A AR the Map Set. You can choose to include auto-routing data or terrain shading
Dz aote: Missau North Ameica. data if your GPS unit supports these functions. To include this data, check
Dakeille, Missour Marth America.

the boxes at the bottom of the Maps tab.

A NOTE: You can view a MapSource Tutorial on the MapSource
setup CD to learn how to select maps and download them to your
GPS unit.

NOTE: Not all Garmin GPS units can use detailed maps. Check
4 | B your GPS unit owner’s manual to see if your unit is compatible.

4 Map(s]-9.13ME

IV Include route caleulation data,

[Recommended if your GPS supparts auto-rau Number Of maps Total memory required
= |relude terratn shading data, in the Map Set to store the Map Set
[Hecommended if vour GRS supports termait sl in the Map Se

2 Map(s) - 7.38 MB

Set ; - - =
IMap Set Mame: | D& Soto, Missour, B allwin, Check ifyour GPS I e - B etior i

[Fecommended if your GP'S supports auto-rou

unit supports auto-

A Map Set appears as a list of area maps in the Maps tab. i Incluc ferrsin shading data,

routing [Fecommended if vour GRS supparts terrain &l

: ap Set Name:éi Ballwin, Miszoun, St Louis, |
Click to change | ~—— Map Set Name
Map Set name
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Adding Maps from Multiple MapSource Products

You can add maps from more than one MapSource product to a Map Set,
but you will only see data from one product on your GPS unit if the maps
overlap. The maps are not transparent on the unit and cannot be combined.
If two maps from different MapSource products overlap on your GPS unit, M ap Sets
you need to turn the overlapping map off in order to see the other map
underneath. Check your GPS unit owner’s manual to learn how to turn
MapSource maps on or off. Adding Maps to a Map Set

Reference

For example, if you select both Topographical and Roads & Recreational i 2 7
data for the same geographical area, you WILL NOT see a combination |} el '-E |.' ;éla?eﬁl
of topographic and road data. You will only see data from the Roads & eate N by
Recreation data set. In order to see the Topographical data, turn the Roads
& Recreational data off in your GPS unit.

A NOTE: You must unlock your MapSource product (if necessary)
to add maps to a Map Set. See “Unlocking Maps,” p. 8, for more

information.

. A
. Jersgyville
WE\TS\,‘/HIE', S s g

To add maps to a Map Set:
1. Zoom to 30 miles (50 km) on the zoom scale.

2. Click the Map tool or choose ‘Map’ from the Tools menu. When
you place the mouse over the map, you will see area maps outlined in
yellow. The name and size of the map appear in the Status Bar.

3. Click the left mouse button to add the map to the Map Set. To select
several area maps at once, click and drag the mouse over the areas you

Maps added to a Map set appear outlined in pink.

want to select. Each selected map will be highlighted in pink. NOTE to BlueChart Users: Once maps
A NOTE: Some MapSource products sell area maps separately. You are selected they are outlined in pink
can only select maps that you have purchased and installed on rather than shaded.
your computer.
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Map Sets

To remove a map from the Map Set:
1. Click the Map tool [E¥ | and place the mouse inside the border of the
area map you want to remove.

2. Click the left mouse button. To remove several maps at once, hold the
Ctrl key and then click and drag the mouse to draw a box through
highlighted areas on the Graphic Map.

OR:

1. Highlight the area map you want to remove in the Maps tab list. To
select several maps, hold down the Shift key on your keyboard and
click the desired maps.

2. Click the right mouse button and select ‘Delete Map,” press the Delete
key on your keyboard, or select ‘Delete Map' from the Edit menu.

To rename a Map Set:
1. Click Map Set Name at the bottom of the Maps tab.

2. Enter a new name in the ‘Name' field and click OK.



Transferring MapSource Data

You can transfer Map Sets, waypoints, routes, and tracks to a GPS unit Reference
or storage card from the MapSource program, or from a GPS unit or storage
card to the MapSource program. You can transfer data in a variety of ways, .
depending on what GPS unit you have. Always check your GPS unit owner’s Transferrlng
manual to see what data transfer options are available. M apSou rce Data

You may use one of the following methods to transfer data to or from

your GPS unit:
The Transfer Toolbar

EEN

o Serial or USB Cable— With this method, you can transfer maps,
waypoints, routes, and tracks to and from your GPS unit.

USB Data Card Programmer— If your GPS unit uses a Garmin data
card (not pre-programmed), you can use this proprietary data card
programmer (o transfer maps, waypoints, routes, and tracks. How- Receive From Device Tool
ever, not all Garmin GPS units can read waypoints, routes, and tracks
that have been transferred to the data card (maps can always be read).

Send To Device Tool

Each time you transfer maps or other data to your data card, you
will completely erase all data currently stored on the card and
replace it with new data. The only exception is this: if you store
maps on a data card and you transfer waypoints, routes, or tracks,
you will not erase the maps on the card. You may be able to save
waypoints, routes, and tracks from a data card to your GPS unit’s
internal memory. That way, if you load new data on your data card,
you will still have the old data stored in your GPS unit. You cannot
save maps from a data card to your GPS units internal memory!

A NOTE: The USB Data Card Programmer operates only with Win-
dows 98, Windows 2000, Windows ME, or Windows XP.
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Transferring
MapSource Data

¢+ Compact Flash (CF) or Secure Digital (SD) Card Reader— If your
GPS unit uses a CF or SD card, you can purchase a card reader from
a third party to transfer data. You can only transfer maps to and
from a CF or SD card. No other data types can be transferred.

*  iQue users— To transfer data to and from an iQue, you must
synchronize (perform a HotSync®). You can send maps to your iQue
and receive tracks with Track Conduit, which you can download
from http:/fwww.garmin.com. See p. 51 and 53 for more information
on transferring data to and from an iQue.

*  cf Que users— You can transfer maps, waypoints, routes, and tracks
to and from your cf Que. If your cf Que does not automatically
synchronize (perform an ActiveSync®) when connected to your
computer, you may need to synchronize after transferring data.

For BlueChart, Fishing Hot Spots, and LakeMaster Users
Pre-programmed BlueChart, Fishing HotSpots, and LakeMaster data
cards should not be used in the USB Programmer or in a GPS unit for saving
MapSource maps—you will lose the pre-loaded data! Make sure you remove
this pre-programmed data card from your GPS unit before you transfer
maps. MapSource will warn you if you are in danger of erasing data. If you
overwrite the pre-loaded data, Garmin will not replace or recover it.

Pre-Loaded Map Data

If your GPS unit includes a pre-loaded/pre-programmed Points of Inter-
est (POI) database, you will see a warning about erasing this pre-loaded
data before you save MapSource maps. (This warning does not refer to the
basemap of your unit.) The pre-loaded data can be restored to your GPS
unit by downloading it from the Garmin web site.



To reload Points of Interest:

1. Go to http://www.garmin.com.

Click "Software Updates' on the left side of the page.

Click the name of your GPS unit.

Click to accept the terms of the Software License Agreement.

Click the ‘Download’ link located under ‘Download Preloaded Marine
POl Database.’

Any MapSource maps on your GPS unit will be erased and replaced with
the POI database.

SAREES I N

Transferring Data from MapSource to a GPS Unit

If your GPS unit has a storage card, be sure the card is inserted correctly
into the unit. Also, make sure your GPS unit is connected to your computer.
Set your unit’s Data Transfer mode to ‘Garmin’ if applicable. See your GPS
unit owner’s manual for further instructions. Then follow the instructions
below that correspond to your GPS unit.

A NOTE: MapSource transfers all of the data listed in a data tab to
your GPS unit each time you transfer data.

To send data to a serial GPS unit:

1. Click or choose ‘Send To Device' from the Transfer menu.

2. The name of your GPS unit should automatically appear in the ‘Device’
drop-down menu. If not, click Find Device.

3. Under ‘What to Send,’ check the boxes next to each type of data you
want to send.

4. Click Send. MapSource will begin sending data to your GPS unit. After
you begin transferring data, you can check the box next to ‘Turn Off
GPS After Transfer" if you wish.

Reference

Transferring
MapSource Data

The Send To Device Icon

=)

Sending Data to a Serial GPS Unit

Send To Device 1 ll

~ Device Settings

If wou don't see your device listed below,
connect it to the computer and turn it on,
then click Find Device,

Find Device |

Device: |Rina 120 (COML) =l
Baud Rate: |11sznn ‘I

If errors occur, use a lower baud rate.

—Ywhat To Send
¥ Maps ¥ Routes
i~ W appoints ¥ Tracks
Send |
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Transferring
MapSource Data

Sending Data to a USB GPS Unit

Send To Device K

Device Settings

1F you don't see your device listed below,
connect it ko the computer and burn it on,
then dick Find Device.

Find Device
5C (U

Device: [[EE,

CWhatToSend—————————————
¥ Maps ¥ Routes
IV wappoints ¥ Tracks

Sending Maps to a CF or SD Card Reader

Send To Device x|

~Device Settings

TF you dont ses your devics listed below,
connect it ko the computer and burn it an,
then click Find Device.

Find Device
Device: |Storage Card Reader (K:) [

~What Ta Send
¥ Maps I~ Aoutes
I waypoints I~ Tracks

To send data to a USB GPS unit:

1.
2.

Click || or choose ‘Send To Device' from the Transfer menu.

The name of your GPS unit should automatically appear in the ‘Device’
drop-down menu. If not, click Find Device. If you are using a cf Que,
select where you want to save data under the ‘Map Storage Location’
field.

Under ‘What to Send,’ check the boxes next to each type of data you
want to send.

Click Send. MapSource will begin sending data to your GPS unit. You
can check the box next to ‘Turn Off GPS After Transfer’ if available.

To send data to a USB Card Programmer:

1.
2.

4.

Click || or choose ‘Send To Device' from the Transfer menu.

You should see "USB Data Card Programmer” in the ‘Device’ field. If not,
click Find Device.

Under ‘What to Send," check the boxes next to each type of data you
want to send.

Click Send. MapSource will begin sending data to your data card.

To send maps to a CF or SD card reader:

1.
2.

Click || or choose ‘Send To Device' from the Transfer menu.

You should see ‘Storage Card Reader’ followed by a drive letter in the
‘Device’ field. If not, click Find Device. Make sure to select the correct
drive letter from the 'Device’ field.

Click Send. MapSource will begin sending maps to your CF or SD card.
Remember, you can only send maps to your CF or SD card.



To send maps to an iQue:
1. Click or choose ‘Send To Device’ from the Transfer menu.

2. You should see ‘iQue’ followed by a user name in the ‘Device’ field. If
not, click Find Device. Select the correct user name.

Reference

3. Under the ‘Map Storage Location’ field, select where you want to save

Transferring
your maps. Make sure ‘Maps' is checked under ‘What to Send.’

MapSource Data

Sending Maps to an iQue

4. Click Send. MapSource will begin sending maps. Remember, you can
only send maps to your iQue.

5. Synchronize your iQue with your computer (perform a HotSync®) so E— X
that your iQue will receive the maps. O i
connect it b the computer and tum ko,
then dick Find Device,
To send data to a cf Que: |
- ; . cever | FET TR |
1. Click or choose ‘Send To Device' from the Transfer menu. T

2. You should see ‘cf Que" in the ‘Device’ field. If not, click Find Device. Ceriecigal ) Crd
3. Under the ‘Map Storage Location’ field, select where you want to save B _
your data. & Mass e ‘
I Wi = Trscks
4. Under ‘What to Send,’ check the boxes next to each type of data you ——
want to send. [Coed ] comn |
5. Click Send. MapSource will begin sending data to your cf Que.
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Transferring Data from a GPS Unit to MapSource
If your GPS unit has a storage card, be sure the card is inserted correctly

Reference into the unit. Also, make sure your GPS unit or card reader is connected to
your computer. Set your units Data Transfer mode to ‘Garmin’ if applicable.
Transferri ng See your GPS unit owner’s manual for further instructions. Then follow the

instructions below that correspond to your GPS unit or card reader.

MapSource Data

The Receive From Device Icon

To receive data from a serial or USB GPS unit:
1. Click or choose ‘Receive From Device' from the Transfer menu.

H 2. You should see the name of your GPS unit in the ‘Device’ field. If not,
click Find Device.

Receiving Data from a Serial GPS Unit 3. Under ‘What to Receive,” check the boxes next to the types of data you
Receive From Device x| Want tO receive.
~Device Settings———————————— 4. Click Receive. MapSource will begin receiving data from your GPS unit.
e
then click Find Device. . d f USB c d P .
— To receive data from a ard Programmer:

1. Click or choose ‘Receive From Device' from the Transfer menu.

2. You should see 'USB Data Card Programmer” in the ‘Device’ field. If not,

~What To Receive . . .
: click Find Device.

W Maps ¥ Routes
il i i 3. Under 'What to Receive, check the boxes next to each type of data you
Cencel want to receive.
4. Click Receive. MapSource will begin receiving data from your
data card.
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To receive maps from a CF or SD Card Reader:

1.
2.

Click or choose ‘Receive From Device' from the Transfer menu.

You should see 'Storage Card Reader’ followed by a drive letter in the
‘Device’ field. If not, click Find Device. Make sure to select the correct
drive letter from the ‘Device’ field.

Click Receive. MapSource will begin receiving maps from your CF or
SD card. Remember, you can receive only maps from your CF or
SD card.

To receive tracks from an iQue:

1.

6.

If you have not downloaded Track Conduit, you can do so at
http://www.garmin.com.

Synchronize your iQue with your computer (perform a HotSync®) so
that your iQue can send tracks.

In MapSource, click or choose ‘Receive From Device' from the
Transfer menu.

You should see ‘iQue’ followed by a user name in the ‘Device’ field. If
not, click Find Device. Select the correct user name.

Under "What to Receive," make sure the box next to ‘Tracks' is checked.
Click Receive. MapSource will begin receiving tracks from your iQue.

To receive data from a cf Que:

1.
2.
3.

Click or choose ‘Receive From Device' from the Transfer menu.
You should see ‘cf Que” in the 'Device’ field. If not, click Find Device.

Under ‘What to Receive,” check the boxes next to the types of data you
want to receive.

Click Receive. MapSource will begin receiving data from your cf Que.
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~Device Settings

1F you don't see your device listed below,
connect it to the computer and Eurn it on,
then click Find Device.

Device: [Storage Card Reader (K1) 7

[~ What To Receive
¥ Maps I~ Routes

IS ayptints ™ Tracks

Reczive Cancel

MapSource Data
Receiving Maps from a CF or SD Card
=]

Receive From Device

~Device Settings

1F you don't see vour device listed below,
connect it o the computer and turn it on,
then click Find Device.

Find Device
Device: [iQue (Jennifer) B

Receiving Tracks from an iQue

x|

- What To Recsive
I~ aps ™ Foutes
I/ ayprirts ¥ Tracks
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Waypoints

Waypoint Properties Dialog Box

Mame: |L|563— oK
Symhol: m Cancel
Fosin: [l 0.2 sz 38,027 Shaw On Map

Alkitude: ft ¥ Unknown More Details

When you create a waypoint, you will see the Waypoint Properties
dialog box. Click More Details (o see more waypoint properties
(shown on p. 56)
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Creating Waypoints

A waypoint is any point on the Graphic Map that you store in memory.
You can make a waypoint anywhere on the Graphic Map, including cities,
points of interest, addresses, and intersections. To find features or places
and then create waypoints, see “Finding Places,” p. 57. Once you have
marked (created) waypoints, you can view them on the Graphic Map and
use them to create routes. See “Creating Routes,” p. 62.

When you create a waypoint, MapSource automatically names the
waypoint based on its location. If you create a waypoint on an existing map
feature, MapSource bases the waypoint name on the feature. If you create
a waypoint on an open location, MapSource names the waypoint with a
number. You can change the name of the waypoint and other waypoint
properties at any time (see p. 55-56).

To create a waypoint with the Waypoint tool:
1. Click the Waypoint tool | /| or select ‘Waypoint’ from the Tools menu.

2. Place your mouse pointer at the location where you want to create
a waypoint and click the left mouse button. To create a waypoint in
the center of the Graphic Map, press Ctrl + W on your keyboard. The
Waypoint Properties dialog box appears.

3. Make any changes to the waypoint properties that you wish. See
“Editing Waypoints,” p. 56, to learn what each waypoint property
means.

4. You can link a file (such as a picture or Web page) to the waypoint for
future reference. Click Browse to locate the file on your computer.

5. Click OK to save the waypoint. Click Cancel to exit without creating
the waypoint.



The Waypoint Properties Dialog Box

Once you have created a waypoint, you can access the Waypoint Prop-
erties dialog box at any time to change the properties you have chosen.
View the dialog box in one of the following ways:

¢+ Double-click a waypoint name in the Waypoints tab list
¢+ Double-click a waypoint on the Graphic Map

¢ Highlight a waypoint in the Waypoints tab list or on the Graphic
Map, then click the right mouse button and select ‘Waypoint Prop-
erties.”

*  Highlight a waypoint in the Waypoints tab list or on the Graphic
Map, then select ‘Waypoint Properties’ from the Edit menu.

Naming Waypoints— Initially, the name of the waypoint will be six
characters long. Keep in mind that most Garmin GPS units limit way-

point names to six characters. If you name a waypoint with more than six
characters, the name may be cut off when you transfer the waypoint to your
GPS unit. If multiple waypoints have identical names when cut off, only one
of the waypoints will be stored in the GPS. Refer to your GPS unit owner’s
manual to determine your GPS unit’s limitations.

Writing Comments— Some GPS units have a maximum number of char-
acters allowed in the comment field. If the comment that you enter exceeds
the maximum amount of characters, the comment will be cut off. Refer to
your GPS unit owner’s manual to determine your unit’s limitations
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The Waypoint Properties Dialog Box

Il
R = o
Symbol: | W waypoint - Lfall
st [z e

Altitude: I— ft ¥ Unknown
Depth: ft [ Unknown  Categories:
Proxinity: [ mi [ Lnknawn EE::;S::;
Tewpereae [ T [ aoonn | D253
Comment: | US 63
Display: [Symbol hame.¥]

Ocateqory s
Date Modified: 5/6/2004 4:29:26 PM

Ocategory &
Ocategory 7
Ocategory
Ocateqary o =l

Link.

’;\MURL; [ g garmn, com @ | orowse.. | |

See p. 56 for a detailed description of each property.
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Editing Waypoints

Reference

Waypoints

Name the waypoint here.

Choose from over 100 Click L
different symbols. Your ; ;l:d et;tsc;hy;l; cz:ies
GPS may not support all Waypoint Properties = II:IIlI S '
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Harme: I L83 e |/ Click to exit dialog box
Position of waypoint on |_— without saving changes.
map, shown according to ~ Symbal: I B Yaypoint ﬂ Cancel :l

Click to show waypoint in the
Position Format chosen
Jor map T~ Fosition: | N41 28,239 Wz 39,027 Shaw On Map | _+— center of the Graphic Map.
/Altitude: | ft v Urknown Click to show fewer
Enter altitude, depth. — : }
o P, waypoint properties.
proximity, and | ————Degth: | ft ¥ Unknown  Categories:
temperature, if known. Cicategary 1 =
Proimity: | mi W Urknown Ocateqory 2
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Temperature: | °F ¥ Unknown s categories whereyou
Enter a comment here. O Category 4 . .
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Commenk: IUS 63 el e "
— O category & To set up categories,
Choose how you want to Dy, )
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Ispiay the waypoint on _—— O cCategory & the Edit menu. See p. 26.
the Graphic Map. Date Madfied: 5(6{2004 4:29:26 PM O category & =l
Link
’7File,|’URL: I hittp fenanar . garmin, com ([’.>J Browse... |
/ = ™~
/ | ™ Click to find file on
your computer.
Link a file, such as an Click to view linked file.

image or web page, to
56 your waypoint.



Finding Places

In order to create routes, you need to have somewhere to go! With some
MapSource products, you can use the Find Places feature to locate cities,
points of interest (such as restaurants, parks, and shops) addresses, intersec-
tions, or waypoints. If you have not unlocked your MapSource product,
your search options will be greatly reduced. To get the most out of your
MapSource product, unlock your maps. See “Unlocking Maps,” p. 8.

Once you have found a place you want to visit, you are ready to create a
route to that place. See “Routes,” p. 62 for more information.

NOTE: You may have fewer Find Places options, depending on
your MapSource product.

As you type places to search for in the Find Places dialog box,
MapSource uses an “auto-complete” list to make suggestions. For example,
as you type in the name of a city, a list of cities will appear containing the
letters you are typing. You can choose the city directly from the auto-com-
plete list or finish typing the name of the city.

NOTE: If the place you are searching for does not appear in the
auto-complete list, MapSource will not allow you to continue typ-
ing. Make sure you are spelling the name of the place correctly.
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The Find Toolbar

| oa|a| &

The Find Places Dialog Box

4 Find Places
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The Find Places Icon

i

Finding a Point of Interest

Place Category: | Food & Diirk =] Fird |
Place Subcategon: [Dei/Bakery =1
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Country: |
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To find a city:
1. Click or select ‘Find Places’ from the View menu. The Find Places
dialog box appears.

2. Under the City tab, enter a city name in the 'City’ field. To narrow your
search, enter the state, province, or country. Highlight the name of the
city in the auto-complete list or finish entering the city name.

3. Click Find to show a list of city/state matches in the search results list.
As you highlight each city name, you will see the city in the center of
the Graphic Map.

4. Highlight the correct city and click Make Waypoint if you want to use
this city as part of a route. Otherwise, click OK to close the Find Places
dialog box. Click Cancel to exit and return to the part of the map you
were previously viewing.

To find a feature/Point of Interest (POI):
1. Click [#4] and then the Feature tab.

2. Select a category from the Place Category drop-down menu. To
narrow your search further, select a sub-category from the Place
Subcategory drop-down menu.

3. Enter the name of a feature and the city and state to search for a
specific point of interest, or enter only the city and state to search for
all points of interest of that type in a city. Then click Find.

4. Highlight the correct feature from the list under ‘Places.’ To view the
feature's address and telephone number, click Properties. Click Make
Waypoint if you want to use this place as part of a route. Click OK to
exit. Click Cancel to exit and return to the part of the map you were
previously viewing.



To find an address or street:
1. Click [#4] and then the Address tab.

2. If you are searching for an address, enter the number of the address in
the "Number” field.

3. To enter a street name, click Select and begin typing the street name.
Do not type directional words (such as North or N) or types of streets
(Dr, Ave, St, Rd). Highlight the correct street name from the list and click
Select Street.

4. To narrow your search, enter the city, state, or both and then click Find.
Alist of addresses or streets will appear under ‘Places.’ If you see the
message, ‘No items found," try using another more general street name.

5. Highlight the correct address or street to view it on the map. Click
Make Waypoint to create a waypoint at this address. Click OK to exit
the dialog box. Click Cancel to exit and return to the part of the map
you were previously viewing.

To find an intersection:
1. Click [#4] and then the Intersection tab.

2. Click Select, enter the first street name, and click Select Street.
Repeat these steps for the second street name. To narrow your search,
enter the city, state, postal code, and country if available, and then click
Find.

3. Enter additional information such as city or state to further narrow your
search and then click Find. A list of intersections will appear under
‘Places.’

4. Highlight the correct intersection to view it on the map. Click Make
Waypoint to create a waypoint at this intersection. Click OK to exit the
dialog box. Click Cancel to exit and return to the part of the map you
were previously viewing.
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Finding an Address
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Selecting a Street
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Finding a Waypoint
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To find a waypoint:

1.
2.

Click ﬂ and then the Waypoint tab.

Type the name of the waypoint you want to search for in the ‘Name'
field. Highlight the correct waypoint in the auto-complete list and then
click Find. A list of waypoints will appear under 'Places.’

Highlight the correct waypoint from the ‘Places’ list. You will see the
waypoint in the center of the Graphic Map. Click Properties to rename
or modify the waypoint. Click OK to exit the dialog box. Click Cancel to
exit and return to the part of the map you were previously viewing.

NOTE: The Waypoint tab is only displayed in the Find Places
dialog box if you have created waypoints or transferred them into
MapSource from your GPS unit.




Finding Nearest and Recently Found Places

Find Nearest Places locates features, points of interest, and other places
near a specific location on the Graphic Map. You can find places nearest
a waypoint, any map location, or the center of the Graphic Map. Recently
Found Places lets you quickly access places you have searched for recently.

To find places nearest a location:

1. Click @ to find a place near the center of the Graphic Map, or right-
click a location or a waypoint on the Graphic Map and choose ‘Find
Nearest Places.’

2. Search for cities, points of interest, addresses, streets, intersections, or
waypoints as described above.

To view recently found places:
1. Click @] or choose 'Recently Found Places’ from the Find menu.

2. Choose a place from the list of recently found places. The location will
appear in the center of the Graphic Map. Click Make Waypoint if you
want to use this location in a route. Click OK to exit. Click Cancel to
exit and return to the part of the map you were previously viewing.
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Finding a Nearest Place
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The Route Tool

o

Creating Routes

Routes tell you how to get from one place to another. You can create
and modify routes in MapSource by using the Route tool | .=| on the Tools
toolbar, or by using the Route Properties dialog box. Depending on your
MapSource product, you can create a direct route (a straight-line route, “as
the crow flies”), or an auto-route (turn-by-turn over roads). See p. 27 to
change the way MapSource calculates routes.

A NOTE: Not all MapSource products can create an auto-route.
You must be using a routable MapSource product for
MapSource to automatically calculate a route.

Using the Route Tool

With the Route tool, you can create routes by clicking each point or
place on the map you want to include. Select the Route tool in one of the
following ways:

¢ Click the Route tool .

e Select Route from the Tools menu.

¢ Click the right mouse button where you want to start the route on
the Graphic Map and select Begin Route.

You can also create routes, add waypoints to routes, and rearrange routes
with the Route Properties dialog box. See “Using Route Properties,” p. 65.



To create a route with the Route Tool:

1. Click | .=| and then click the waypoints or map locations in the order
you want them to go in the route. If you click directly on the map
(not a waypoint), MapSource creates a new waypoint at that location
and names it automatically. Each time you click to add a point to the
route, you will see lines (direct routes) or colored lines along roads
(auto—routes) that connect one point to the next.

2. If you want to add waypoints or features to your route that are far
apart on the Graphic Map, use Find Placesto locate them quickly
on the map while you are in the middle of creating your route. See
“Finding Places,” p. 57, for more information.

3. When you have finished adding points to your route, press Esc on your
keyboard or right-click the last point on your route and select Cancel.
MapSource will list the route under the Routes tab and name the
route automatically using the names of the first and last waypoints.

To insert waypoints into a route on the Graphic Map:
1. Click the Selection tool .

2. Click a route on the Graphic Map to select it, or click the route name
listed under the Routes tab. When you select a route, it is highlighted
in yellow.

3. Click the left mouse button on the route leg you want to add a
waypoint to. The mouse pointer will change to show a (+) and a small
route icon, and the route will appear “flexible.” If you click a part of
the route by mistake, press Esc on your keyboard.

4. Drag the mouse to the waypoint or location on the map you want to
add and click the left mouse button to add that point to the route.

5. Repeat these steps to insert additional waypoints. Click the left mouse
button away from the route or press the Esc key on your keyboard to
quit and save the changes to the route.
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Creating a Route with the Route Tool
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As you connect each waypoint or location on the Graphic Map,
MapSource calculates turn-by-turn directions (if using auto-routing)
and highlights the route for you. Add points to a route with the
Selection Tool by clicking a route leg and dragging it to another
waypoint or location on the map.
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Moving a Waypoint to a New Location
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Click the waypoint you want to move and drag it to a new location
on the map. When you release the mouse button, MapSource will
recalculate your route to include the new location.
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To add a waypoint to the beginning or end of a route:

1.
2.

Click the Selection tool .

Click a route on the Graphic Map to select it, or click the route name
listed under the Routes tab. When you select a route, it is highlighted
in yellow.

Click the first or last waypoint in the route. The mouse pointer changes
to show a (+) and a small route icon.

Drag the mouse to the waypoint or map location you want to add to
the route and click the left mouse button.

Repeat these steps to add more waypoints. Click the right mouse
button and select Cancel, or press the Esc key on your keyboard to quit
and save changes to the route.

To move a waypoint to another location in a route:

1.
2.

Click the Selection tool .

Click a route on the Graphic Map to select it, or click the route name
listed under the Routes tab. When you select a route, it is highlighted
in yellow.

Click the waypoint you want to move. The mouse pointer changes to
show a curved arrow and a small Waypoint icon, and the route appears
“flexible.”

Position the mouse pointer where you want to move the waypoint and
click the left mouse button to move the waypoint.



To remove a waypoint from a route:

1. Click the Selection tool .

2. Click to select the route waypoint you want to remove. Then right-click Reference
and select 'Remove Waypoint from Route’ or press Ctrl + Delete.

ﬁ NOTE: If you highlight the waypoint and simply press Delete, you Routes
will delete the waypoint from MapSource.

Route Properties Dialog Box

Tt a— X

Using Route Properties
You can create a route with the Route Properties dialog box by insert-

N T
ing existing waypoints and, with some MapSource products, you can insert =0
points of interest, cities, or addresses with Find Places . Open the Yia P | Disciors |
Route Properties dialog box by selecting ‘New Route’ from the Edit menu 8[| @]x ||| a8]sb|&]
or by pressing Ctrl + R on your keyboard. ﬂ = |

You can also create routes, add waypoints to routes, and rearrange routes |« e i Wt
with the Route tool | ,=| dialog box. See “Using the Route Tool,” p. 62. . o ==
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See p. 66 for a more detailed image.
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The Route Properties Dialog Box
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To create a route with Route Properties:

1.
2.

6.

Open the Route Properties dialog box (press Ctrl + R).

To add an existing waypoint to the route, click Insert Waypoint.
Choose the waypoint from the list that appears and click OK.

To add a city, point of interest, address, or intersection that you have

not already marked as a waypoint, click Find Places ﬂ inside the
dialog box under the Via Points tab.

Repeat steps 2 and 3 until you are finished adding points to your route.

As you add each point, you will see the points listed in order from first
to last under the Via Points tab.

To rearrange the points in the list, highlight each point and click the
arrows to move the point up or down in the list. To reorder the points
from last to first, click Invert. To see points on the map, highlight each
point and click Show on Map, or check the box next to Center map
on selected item to see each point in the center of the map.

Click OK to save the new route.

To add a point to a route with Route Properties:

1.

4

Double click the route under the Routes tab to open the Route
Properties dialog box.

Determine where you want to add the point to your route. Then
highlight the via point in the list directly below where you want to
add the point. To add the via point to the end of the route, highlight
<end>.

Click Find Places or Insert Waypoint to add the point to your route.
The point appears in the list. To rearrange the points in the list,
highlight a point and click the arrows to move it up or down in the list.

Click OK to save changes. MapSource will recalculate the route.
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Click the Directions tab to view text directions. You can print the text
directions by clicking Print Directions, or you can copy the directions
into another application.
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To rename a route:

1. Double click the route under the Routes tab to open the Route
Properties dialog box.

2. Uncheck the box next to ‘Autoname.” Enter a new name for the route
and click OK to save changes.

To invert a route:
1. Double click the route under the Routes tab to open the Route
Properties dialog box.

2. Click Invert to reorder the route points from last to first. Click OK to
save changes.

To link a file to a route:
1. Double click the route under the Routes tab to open the Route
Properties dialog box.

2. Click Browse to locate the file on your computer you want to link to
the route. Click OK to save changes.

To view and print text directions for an auto-route:

1. Double click the route under the Routes tab to open the Route
Properties dialog box.

2. Click the Directions tab to view text directions, distance, leg length,
leg time, and course for the route.

3. Click Print Directions to print.

To delete a route:

1. Use the Selection tool M to select a route on the Graphic Map, or
click the route name listed under the Routes tab. When you select a
route, it is highlighted in yellow.

3. Click ﬂ press the Delete key on your keyboard, or click the right
mouse button on the highlighted route and select 'Delete Route.’



Tracks and Real-Time Tracking
Think of a track as a trail of footprints: the trail shows you exactly where

you have been. Each “footprint” of the track is called a track point. As you Reference

move, your GPS unit records a track point every second (by default) with

the time and your position and speed. Your GPS unit then saves these points Tracks and Real-Time
as a track. Tracki ng

You can record your own real-time tracks in MapSource using your GPS
unit and a laptop computer. When you begin real-time tracking, MapSource

reads information from your GPS unit, shows the GPS unit on the Graphic The Tracks Tab
Map, displays track data in the GPS tab, and records a track. [Fo e Vow ook b
P Py MECIENEECE | WetioGude U4
ii NOTE: iQue and cf Que users cannot record real-time tracks with i Do | _
MapSource T T G R T T

01135
FT (0] e e e e A T - T S N1
ACTIVELDG 009 766 G/A/200371437FM 002530  1(Bm O04Zsqm  25mph

& NOTE: To record real-time tracks, you must unlock your
MapSource product, if necessary. See “Unlocking Maps,” p. 8.

You can also view tracks in MapSource that you have received from your
GPS unit. The tracks appear in the Tracks tab after you receive them. See
“Transterring Data,” p. 47 to learn how to receive data from your
GPS unit.
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The GPS Tab
Use the GPS tab to begin and end real-time tracking. The tab displays
Reference

information about the current track, allows you to begin a new track, and
allows you to change the way MapSource records track points.

Tracks and Real-Time
Tracking

Routes(1] | Tracks(4] GPS
Click to stop tracking or
to start tracking.
3D Navigation
Speed Altitude
30.0 mph 1085 ft

Shows current speed | “0° true \\Shows current altitude.

Shows current
compass heading.

Shows current position.

Shows current date
Estimated Position Error,

: N38 51.338 W94 47.929 - and time.
shows estimated accuracy 272812003
of your position on map. RRERAET
e |DDP Dil}ution O]f Prec]is‘ion, shows
Check to keep your GPS unit L2 e del 1o e Fate m.ets. caz
. o o etermine your position by a
visible on Gmph]c Map' T Keep vehicle wizible an map numberfmm 1-10. A lower
| ¥ Record rack number is better:
Check to record track. Filer... | SelectDevice..
, | Click when not currently
Click toﬁlter traching to select the GPS
track points. unit you want to use for
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To start Real-Time Tracking:
1.

5.

To view a Track on the Graphic Map:
1.

Make sure your GPS unit is connected to a serial or USB port on your
computer. Set the Serial Data Format on your GPS unit to Garmin or Reference
NMEA, if applicable. Some older GPS units do not support Garmin
format. See your GPS unit owner’s manual for instructions.

In MapSource, click the GPS tab and then click Select Device. Click Tracks and Beal Time
‘Serial Port’ or 'USB Device” to indicate how your GPS unit is connected Tracklng

to your computer. If you are using a serial port, choose the correct serial
port from the list (COM1 or COM2). If you choose ‘'USB Device," make
sure the name of your GPS unit appears in the drop-down menu to the
right.

Check the box next to ‘Record track” and then click Start Tracking.
MapSource will begin to track and record your movements. You will

see a message under Start Tracking that describes what information
MapSource is receiving. The recorded track will be listed under the
Tracks tab. =

Check the box next to ‘Keep Vehicle Visible on Map” so that your GPS ==
unit is always in the center of the Graphic Map.

Viewing Tracks on the Graphic Map

S BB

Ove.1and K

When you are finished recording tracks, click Stop Tracking.

Highlight the track name in the Tracks tab. The track will appear Tracks on the Graphic Map appear as dotted lines that are
highlighted in yellow on the Graphic Map. highlighted in yellow.

Right-click on the track and select ‘Show Selected Track on Map' to see
the entire track in the center of the Graphic Map. Zoom in to view track
points and track legs.
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Viewing and Editing Track Properties

The Track Properties dialog box lets you change the track name, invert
the track, view a vertical profile of the track, and view and edit track points.
To open the Track Properties dialog box, double-click a track in the
Tracks tab or right-click the track and choose ‘Track Properties.’

Reference

Tracks and Real-Time
Tracking

Click to show selected track
in center of Graphic Map.

Cut, Copy, Paste,

Delete, Undo, Redo
Click to save changes

Shows name of track.
Enter new name if desired.

Shows all recorded

lnformat}lzonfor each \\ Index | Time | Altitude | Leg Length | Leg Time | Leq Speed | Leg Course | Position :I
track point. T~ 4/6/2004 11:28:56 AM  1153ft 24 Ft 00:00:14 1.2mph 15°true  W3E 51,325 o
2 4/6/7004 11:2%:10 &M 1122 ft 47 Ft 00:01:00  0.54mph  7° brue N3 51,329 We

& Track Properties

ACTIVE LOG 001

Track Paints:

4 | o | @] x| ]|

v Center map on selected itemis)

4 4 1 0 AR

1119t

0.14 mph

90° true

to track and exit.

Click to exit without
saving changes.

4 4/6/2004 11:30:40 AM  1128Ft  20Ft 00:00:30 0.45mph  203° brue  M38 51,337 WS
5 4f6/2004 11:31:10 &M 1125ft  10Ft 00:00:30 0.23mph 38%true W3S 51,335 WS
6 4f6/2004 11:31:40 &AM 1090Ft  SFt 00:00:30 O.8mph  180° true  M38 51,340 WS
7 4f6/2004 11:32:10 AM 1078 Ft 6 ft 00:00:30 0,14 mph  90° brue N33 51,335 WS Click to reverse the
8 4/6/2004 11:32:40 AW 1071Ft Bt 00:00:30 O.14mph  270° true W38 51,335 WS .
n AP IO0A 1102010 AR 1NEn FE & F AO2n. N14 ek Lalat-R RPN A20 1 220 WA = Order Of traCk p()lnts
4| | »
Shows totals for ’
information gathered for —J—Track Statistics: Ivert |/ ClIC‘k to filter track
highlighted track point. [ Points | Length [ Area [ ElapsedTime | Avg, Speed = points of selected
| 1 | 6 | osqft | 0000:30 | 0.14mph Fileer ... :lf track. See p. 72.
Link Show Profile. . ;I\\ Click to show vertical
Fils{URL: | hikbp:  franana . garmmin, com I | Browse... | e track Pmﬁ{e: U‘available.
,’ / N\ Seep. 73.
Click to show
Link a file, such as an image Click to view Find file/URL on highlighted track

or web page, to this track. linked file. computer to link to. on map.
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To invert a track:
1. Open the Track Properties dialog box.

2. Click Invert. MapSource automatically reverses the order of track
points. Click OK.

Reference

To link a file to a track: Tracks and Real-Time

1. Open the Track Properties dialog box. Tracking

2. Click Browse. Find the file on your computer you want to link to this
track and click OK. The name of the file will appear in the ‘File/URL
field.

3. Toview the file, click the Open Link icon .

® ¥ertical Track Profile 9 x|

Distance: 302 ft, Altitude: 1325 1t ;I

Altitude (1500 fi

Distance{800 ft) -
|l _'l_I

Altitude: Distance:

ﬂ [ETE E ﬂ T ﬂ I Show Track Paints ;

When you click Show Profile, the Vertical Track Profile dialog box
appears. This box shows you a graphical representation of your altitude and
how it changes over each track point you log. When you click the graph, lines
appear that show you the exact altitude at each track point. Click to move the

lines to different points on the graph.
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Filtering Tracks
When you filter a track, you control how often MapSource records track

points. Each track point consists of the time the point was recorded and

your position and speed. Filtering tells MapSource to record these points

Tracks and Real-Time at specified intervals. You can filter by time or distance, or you can let
Trackin MapSource automatically filter the track points. For example, you can tell

g MapSoutrce to record a track point every thirty seconds or every five hun-
dred feet, or you can let MapSource automatically choose the track points

Reference

Track Filter Dialog Box that best fit your path.
x| .
— ' To filter a track:
('fe'N EE g 1. Tofilter a track as it is being recorded, click Filter on the GPS tab. To
" filter a previously recorded track, open the Track Properties dialog box
{ i [0 R and click Filter.
" Distance 328 X . .
o " 2. Choose whether you want to filter by time, by distance, or
@ Avomatic  Fewsrporis —— | haeionts automatically. If you click ‘Time," enter the length of time you want

— MapSource to wait before recording each track point. If you click

‘Distance, enter the distance in feet you want to move before
MapSource records each track point. If you click ‘Automatic,” move the
slider bar to allow MapSource to record fewer track points or more
track points.

3. Click OK.
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To save a MapSource document:
1. Click the Save icon or choose ‘Save’ from the File menu.

2. Select a location for your MapSource document, name the MapSource
file, and click Save.

To open a previously saved MapSource document:

1. Click the Open icon || or choose ‘Open’ from the File menu. The first
time you open a saved document, you will see the Document Format
dialog box. Click to choose which file type you want to open. Check the
box if you do not want to see the Document Format dialog box again.

2. Browse to the saved MapSource document and click Open.

Only one document can be open in MapSource at a time, so if you open
anew document, MapSource will close your current document. However,
you can run several instances of MapSource simultaneously, allowing you to
move information between documents easily.

Printing the Graphic Map
The Print, Print Preview, and Print Setup options function like other

Windows applications. Choose ‘Print Setup’ from the File menu to select a
printer and set printing properties. You may need to lower the DPI settings
for the image to print.

Select ‘Print Preview’ from the File menu to see a preview of what will
be printed. Click the Print icon |&| or choose ‘Print’ from the File menu to
print the current Graphic Map display. To print text directions for a route,
see “To view and print text directions for an auto-route,” p. 68. To print oth-
er information, you can copy the data and paste it into another application.

Reference

Saving, Opening, and Printing
in MapSource

Document Format Dialog Box

Document Format ]

MapSource now Lses the GDE document format, What would you like ko do?

Import MPS File I ©pen GDE File | Cancel |

Mote: You can also choose Import from
the File menu ko impork MPS files,

x|

I™ Don't show this again
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Importing Data

Importing Files

Lok i [ yoeet = ~msm

Importing .mps and Garmin PCX5 Data Files

76

You can import files saved in .mps format and Garmin PCX5 data files
to MapSource. MapSource can display waypoints (.wpt), routes (.rte), tracks
(.trk), or one of the maps (.grm) provided with PCX5.

To import .mps or Garmin PCX5 data:

1.
2.

Choose ‘Import’ from the File menu.

Select the type of file you want to import: .mps, .wpt, .rte, .trk, .grm, or
‘All PCX5 files."

Browse to the file you want to open and click Open. If you are opening
a .grm file, you may need to provide more information so MapSource
can import the file accurately.

NOTE: If you are using a PCX5 map outline, you can hide GPS
map detail (press CTRL + G) to avoid screen clutter.




File Menu
New Document .........c.cccv.e. Ctrl + N

Open Existing Document ....... Ctrl+0

Save Document..........cccueuevee Ctrl +S

Print Graphic Map.....c.cccoce... Ctrl +P
Edit Menu

Ctrl+2Z

Ctrl+Y

Ctrl + X

Ctrl + C

Ctrl +V

.......................................... Del

Ctrl + A

New Waypoint...........ccovuene. Ctrl + W

New Route......ccovrvevreririerne, Ctrl +R

New Track .....ccvvrvvnnes Ctrl + Shift + T

Remove Waypoint from Route ...........

.......................................... Ctrl + Del

Preferences ... Ctrl + Shift + P
Find Menu

Find Places.......c.coovveviveriinines Ctrl + F

Find Nearest Places.... Ctrl + Shift + F
Recently Found Places....Ctrl + Alt + F

View Menu

Show Selected Item on Map ..Ctrl + D
Go To Position ........ccevvreenne. Ctrl+T
ZOOM IN ot +
Z00M OUL ..o -
Zoom In MaX.......ccoeveveveinnas Ctrl + +
Zoom Out Region.......c.ccevueee Ctrl + -
GPS Map Detail.......ccovvunne. Ctrl + G
Show Crosshair ........cccceeee. Ctrl + H

Pan Map Right. Ctrl + right arrow key
Pan Map Left ..... Ctrl + left arrow key

Tools Menu
Map Tool

Zoom Tool
Hand Tool ..o h
Waypoint TOOl ......cvveeiicieccicne w
Route Tool..........

Selection Tool
Distance/Bearing ToOl...........ccccuuee. d

Utilities Menu

Unlock Maps......ccocvreinnnnes Ctrl+U
Help Menu
Help File oo F1

Appendix

Appendix A: Keyboard
Shortcuts
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Appendix

Appendix B: Map Legends
Lines and Areas

Street Or Roadway

R:amp

Lrterial Roadway

Cther Through Hwey, State Hwey Or Major Srterial

Principal Hwey, Us, Or Limited Acc Hwey

Major Hwey Connector

Major Huey

Stream Or River

Irtermittert/Dry Stream Or River

i ll?allilrl'oad

Shipping Route

Land Contour

Depth Contour

Folitical Boundary

78

Flet (Tidal, Sand Cravel, Mid, Etc )

Watland

NI e

Golf Course or Park

Man-Made Areas

Metra Areas

RUINATNER

Color map legends can be viewed in the MapSource Help File (F1).



THIS SOFTWARE IS OWNED BY GARMIN LTD OR ITS SUBSIDIARIES
(HEREINAFTER COLLECTIVELY REFERRED TO AS “GARMIN”) AND IS PRO-
TECTED UNDER COPYRIGHT LAWS AND INTERNATIONAL COPYRIGHT
TREATIES. THIS SOFTWARE IS LICENSED, NOT SOLD. THIS SOFTWARE IS
PROVIDED UNDER THE FOLLOWING LICENSE WHICH DEFINES WHAT
YOU MAY DO WITH THE PRODUCT AND CONTAINS LIMITATIONS ON
WARRANTIES AND/OR REMEDIES.

IMPORTANT: CAREFULLY READ THIS LICENSE BEFORE USING THIS
PRODUCT. INSTALLING, COPYING, OR OTHERWISE USING THIS PROD-
UCT INDICATES YOUR ACKNOWLEDGMENT THAT YOU HAVE READ THIS
LICENSE AND AGREE TO ITS TERMS. IF YOU DO NOT AGREE, RETURN
THE COMPLETE PRODUCT TO GARMIN INTERNATIONAL, INC. CUS-
TOMER SERVICE, 1200 EAST 151st STREET, OLATHE, KS 66062 WITHIN 10
DAYS OF THE DATE YOU ACQUIRED IT FOR A FULL REFUND.

1. LICENSE: Garmin (“we” or “us”) provides you with storage media
containing computer software (the “Program”) which may also include digital
cartographic data and “online” or electronic documentation, and printed materi-
als (together called the “Product”) and grants you a limited non-exclusive license
to use the Product in accordance with the terms of this License Agreement. The
copyright and all other rights to the Product shall remain with us. You must
reproduce any copyright or other notice marked on the Product on all copies
you make.

Appendix

Appendix C: Software License
Agreement

2.YOU MAY:

a) install and use one copy of the Product on a single computer or
network. This copy is to be used by only a single user at a time. If you
wish to use the Product for more users, you will need an additional
license for each user.

b) make one copy of the Product for archive or backup purposes.

¢) use a copy of the Product on a home or portable computer if that
copy is never loaded at the same time it is loaded on your primary
computer.

d) transfer the Product to someone else only if you assign all of your
rights under this License, cease all use of the Product, erase or destroy
any copy (including the hard disk copy) made in support of your use
of the Product, and ensure that the other person agrees to the terms of
this License.

3. YOU MUST NOT:

a) make copies of the Product except as expressly permitted in Section
2 of this License.

b) translate, reverse engineer, decompile, or disassemble the Product
except to the extent the foregoing restriction is expressly prohibited by
applicable law.

¢) rent, lease, loan, sub-license, distribute, assign, or transfer the Prod-
uct except as set out in Section 2 (d) above.
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Appendix C: Software License
Agreement

d) modily the Product or merge all or any part of the Product with
another program.

4. TERM: This License shall continue for as long as you use the Product.
However, this License will terminate automatically and without notice from
Garmin if you fail to comply with any of its terms or conditions. You must agree,
upon termination, to destroy all copies of the Product. The Limitations of War-
ranties and Liability set out below apply even after termination.

5. LIMITATION OF WARRANTIES AND LIABILITY: THE PRODUCT
1S PROVIDED ON AN “AS IS” BASIS, WITHOUT ANY WARRANTIES OR
CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED
TO, WARRANTIES OF MERCHANTABLE QUALITY, MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE, OR THOSE ARISING BY LAW,
STATUTE, USAGE OF TRADE, OR COURSE OF DEALING. THE ENTIRE
RISK AS TO THE RESULTS AND PERFORMANCE OF THE PRODUCT 1S AS-
SUMED BY YOU. NEITHER WE NOR OUR DEALERS OR SUPPLIERS SHALL
HAVE ANY LIABILITY TO YOU OR ANY OTHER PERSON OR ENTITY FOR
ANY INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES
WHATSOEVER, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE
OR PROFIT, LOST OR DAMAGED DATA OR OTHER COMMERCIAL OR
ECONOMIC LOSS, EVEN IF WE HAVE BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES, OR THEY ARE FORESEEABLE. WE ARE ALSO NOT
RESPONSIBLE FOR CLAIMS BY A THIRD PARTY. OUR MAXIMUM AGGRE-
GATE LIABILITY TO YOU SHALL NOT EXCEED THE AMOUNT PAID BY YOU
FOR THE PRODUCT. THE LIMITATIONS IN THIS SECTION SHALL APPLY
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WHETHER OR NOT THE ALLEGED BREACH OR DEFAULT IS A BREACH OF
A FUNDAMENTAL CONDITION OR TERM OR A FUNDAMENTAL BREACH.
SOME STATES/COUNTRIES DO NOT ALLOW THE EXCLUSION OR LIMITA-
TION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES,
SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

6. RESTRICTED RIGHTS: If this Product is acquired by or for the U.S.
Government, then it is provided with Restricted Rights. Use, duplication, or
disclosure by the U.S. Government is subject to restrictions as set forth in
subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer Software
clause at DFARS 252.227-7013, or subparagraphs (c)(1) and (2) of the Com-
mercial Computer Software - Restricted Rights at 48 CFR 52.227-19, or clause
18-52.227-86(d) of the NASA Supplement to the FAR, as applicable. The
contractor/manufacturer is Garmin International, Inc., 1200 E. 151st Street,
Olathe, KS 66062, USA.

7. EXPORT CONTROLS: You agree not to export or re-export the Product
to any country in violation of the export control laws of the United States of
America.

8. GENERAL: This License is the entire agreement between us, superseding
any other agreement or discussions, oral or written, and may not be changed
except by a signed agreement. This License shall be governed by and construed
in accordance with the laws of the State of Kansas, United States of America. If
any provision of this License is declared by a court of competent jurisdiction to
be invalid, illegal, or unenforceable, such a provision shall be severed from the
License and the other provisions shall remain in full force and effect.
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.grm files 76
.mps files 76
1te files 76
.tk files 76
wpt files 76

A
About MapSource 34

B
Basemap 20
BlueChart 24, 36, 48, vi
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cf Que
receiving data from 53
sending data to 51

Compact Flash (CF) Card 2, 50
receiving maps from 53
sending maps to 50

Connecting GPS Unit to a Computer 18
verifying connection 18
with serial port 18
with USB port 18

Copying 23

Coupon Code 8
redeeming 9, 11
unlock certificate 11
where to find 8, 11

Crosshair
showing 30

Customer Service i

Cutting 23

D

Data Tabs 19,21
cutting, copying, and pasting data 23
selecting all data 23
sorting data 21

Delete 23

Detailed Maps 20
GPS map detail 20

Distance/Bearing Tool 32,43
measuring area 43
measuring distance 43

DOP (Dilution of Precision) 70

E

E-mail MapSource files 22

Edit Menu 23
preferences 24

Edit Toolbar 23

EPE (Estimated Position Error) 70
Exiting MapSource 22
Exporting files 22

F
File Menu 22
File Toolbar 22
Filtering Tracks 74
track filter dialog box 74
Finding Places 28, 57
addresses 59
and creating waypoints 58, 59
auto-complete 57
cities 58
features 58
finding nearest 61
Find menu 28
find places icon 58
intersections 59
points of interest 58
recently found places 61
streets 59
waypoints 60
Find Menu 28
Find Nearest Places 28, 61
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Find Toolbar 57
Fishing Hot Spots 48

G

Garmin Customer Code 11,15
updating information with 15

Garmin Data Card 2, 47
erasing 33

Garmin Web site 1

Get Unit ID 33

Go To Position 30

GPS Map Detail 76
showing/hiding 30

GPS Tab 70

GPS unit
compatibility with MapSource 1
connecting to a computer 18
storing data 2

Graphic Map 19, 20, 42
basemap 20
changing map font 24
detailed maps 20
displaying map detail 24
measuring distance on 43
panning 42
selecting all data 23
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viewing zoom level 20
zooming 42

H

Hand Tool 32,42

Help Menu 34
contents 34

index 34
|
Importing Files 22, 76
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PCX5 76
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notes 7

reinstalling 3
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uninstalling 7
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InstallShield Wizard 4, 5, 16
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opening 16

removing MapSource 17

repairing MapSource 17
iQue 51

receiving tracks from 53
sending maps to 51

K
Keyboard Shortcuts 32, 77

L
LakeMaster 48
Latitude and Longitude 20
Lines and Areas 78
Linking Files

to routes 66

to tracks 72

to waypoints 56

M
MapSource Documents
opening 75
saving 75
MapSource Interface 19
MapSource Tutorial 44
MapSource Updates 34
Maps Tab 44
right-click menu 41
viewing a map set 44
viewing maps 41



Map Datum 20, 25
Map Features
right-click menu 36
Map Legends 78
Map Sets 44
adding maps from multiple MapSource
products 45
adding maps to 45
cutting, copying, pasting maps 41
deleting maps from 41
removing maps from 46
renaming 46
right-click menu 41
viewing map properties 41
Map Tool 32,45
Measurement
changing units 25
Menus 19
Edit menu 23
File menu 22
Find menu 28
Help menu 34
Right-click menus 35
Tools menu 32
Transfer menu 29
Utilities menu 33

View menu 30
Minimum System Requirements 1
Modifying Mapsource Installation 16

N
Nearest Places
finding 61
New MapSource Document 22

0

Opening MapSource Documents 75
.gdb files 75
.mps files 75

P
Pasting 23
PCXG5 files
importing 76
Position Format 20, 25
Preferences 24
display tab 24
file location tab 26
find tab 26
position tab 25
routing tab 27
time tab 26

units tab 25

waypoint categories tab 26

waypoint tab 26
Preprogrammed Data Cards 48
Preprogrammed Points of Interest (POI)

Database 48

reloading 49
Printing 22,75

DPI settings 75

print preview 22, 75

print setup 22, 75

text directions 68
Product Registration 15, i
Properties

viewing 23

R
Real-Time Tracking 69, 71
starting 71
stopping 71
Receive From Device 52
CF or SD card reader 53
cf Que 53
iQue 53
serial GPS unit 52
USB card programmer 52
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USB GPS unit 52
Recently Found Places 61
viewing 61
Redo 23
Regional Coverage Area
adding 16
deleting 14,16
modifying 16
viewing properties 14
Registering MapSource 15, i
Registration Code 15
Reinstalling MapSource 3
Removing Detailed Maps 16
Removing MapSource 17
Renaming GPS Unit 33
Repairing MapSource 17
Right-Click Menus 35
Map feature menu 35
Route menu 38
Track menu 40
Waypoint menu 37
Routes 62
adding waypoints 64
auto-routes 27, 62

average driving speed, setting 27

avoiding roads 27
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calculation style, changing 27
creating 62, 63, 65

deleting 68

direct routes 27, 62
duplicating 23

finding places and 63, 66
inserting waypoints 63, 66
inverting 68

linking files to 66, 68
moving waypoints 64, 66
recalculating 66

removing waypoints from 23, 65
renaming 66, 68

right-click menu 38

routes tab 63

route properties 65

route styles, changing 27
route tool 62

selecting 63, 64

showing waypoint on map 66
text directions 66, 68
vehicle type, choosing 27

Routes Properties Dialog Box

creating routes with 67

Route Properties Dialog Box 66

adding waypoints 67

inserting waypoints 66
moving waypoints 66
opening 65
viewing 23

Route Tool 32
creating routes with 63

S

Saving MapSource Documents 22, 75

Secure Digital (SD) Card
card 2
receiving maps from 53
sending maps to 50
Selection Tool 32
Select All 23
Send To Device
CF or SD card reader 50
cf Que 51
iQue 51
serial GPS unit 49
USB Card Programmer 50
USB GPS unit 50
Serial Communications Port 1,18
Serial Number i
Set PC Clock 33
Show Item on Map 30



Software License Agreement 79
Splitter Bar 19, 21
moving 21
Status Bar 20
showing/hiding 20, 31
where to find 19
Switching Products 31

T

Text Directions
printing 68
viewing 66, 68

Toolbars 19
Edit toolbar 23
File toolbar 22
Find toolbar 28
showing/hiding 31
Tools toolbar 32
Transfer toolbar 29
View menu 30

Tools Menu 32

Tracks 69
filtering 70,72, 74
GPS tab 70
inverting 73
linking files to 73

naming 72

properties 72

recording 70, 71

right-click menu 40

tracks tab 69

track points 69

vertical track profile, showing 72
viewing 69, 71

Tracks Tab 69
Transferring Data 47

CF or SD card reader 48, 50, 53
cf Que 48, 51,53

from GPS unit to MapSource 52
from MapSource to GPS unit 49
iQue 48, 51,53

serial GPS unit 47,49, 52

USB Card Programmer 47, 50, 52
USB GPS unit 47, 50, 52

Transfer Menu 29

Undo 23
Uninstalling MapSource 7
Units of Measure, Changing 25

altitude/elevation 25
area 25

depth 25
distance/speed 25
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temperature 25
UnitID 33
Unlocking Maps 8, 33
for a second GPS unit 8
on the Garmin Web site 8
with Coupon Code 11
with Unlock Code 10
UnlockWizard 8-15
opening 9, 33
Unlock Certificate 8,11
Unlock Code 8,10
backing up 12
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viewing 14
where to find 8, 10
USB Data Card Programmer 1, 47, 50, 52
USB Drivers 18
installing 18
USB GPS Unit
receiving data from 52
sending data to 50
USB port 1,18
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Vv Waypoint Tool 32, 54
Vehicle

choosing type of 27 Z
Vertical Track Profile 72,73 Zooming
Viewing Recent MapSource Files 22 changing map scale 31
View Menu 30 zoom in 30, 42
zoom in max 30
w zoom out 30, 42
Warnings and Cautions v, vi zoom out region 30
BlueChart vi zoom scale 31,42
Waypoints 54 zoom tool 42
categories 26, 56 Zoom Tool 32

creating 54

creating on a map feature 26

editing 56

finding 60

limiting characters in names 26

linking a file to 56

naming 55, 56

properties 23

right-click menu 37

showing on map 56

symbols 56

using waypoint tool 54

waypoint properties dialog box 55
Waypoint Properties Dialog Box 56

86






For the latest free software updates (excluding map data) throughout the life of your
Garmin products, visit the Garmin Web site at www.garmin.com.
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